
 
 

Odisha OSSC FSO Composite Sample Paper (Paper–I) 
 

Q1. Select the most appropriate conjunction to fill in the blank. 

He insisted on going, _____ I advised him against it. 

(a) while 

(b) since 

(c) as if 

(d) so that 

Ans.(a) 

Sol. The correct option is (a). 

The sentence shows a contrast between two actions: he insisted on going, and at the same time, the speaker 

advised him not to go. The conjunction “while” is used to show contrast or two actions happening in parallel, 

often meaning “whereas.” Hence, “while” fits best. 

Correct sentence: He insisted on going, while I advised him against it. 

Example: She likes tea, while I prefer coffee. 

Why other options are incorrect: 

• Option (b) since: Shows reason/time; it would suggest advising him against it was the reason for insisting, 

which is illogical. 

• Option (c) as if: Used for comparison or unreal manner; it does not suit the contrast between two clauses 

here. 

• Option (d) so that: Indicates purpose; the sentence is not expressing purpose. 

“So the correct answer is (a)” 

 

Q2. What is the one-word substitute for: “A narrative in which abstract ideas are represented through symbolic 

characters and events”? 

(a) Allegory 

(b) Parable 

(c) Fable 

(d) Satire 

Ans.(a) 

Sol. The correct option is (a). 

Explanation: 

An Allegory is a narrative in which characters, events, and settings represent abstract ideas (such as truth, 

freedom, greed) and convey deeper moral, political, or philosophical meanings. (Hindi meaning: रूपक कथा 

/ प्रतीकात्मक कथा) 

It fits the definition because the question specifically mentions “abstract ideas” represented through symbolic 

elements. 

Example: “Animal Farm” is an allegory that represents political ideas through animal characters. 

Meanings of the other options: 

• (B) Parable: A short story that teaches a moral lesson, often religious. (Hindi: दृष्ाांत) 

• (C) Fable: A short tale, usually with animals, teaching a moral. (Hindi: नीततकथा) 

• (D) Satire: Writing that uses humour/irony to criticize. (Hindi: व्यांग्य) 

“So the correct answer is (a)” 
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Q3. Select the most appropriate option to fill in the blanks. 

Monika is _____ very intelligent girl and she is one of ____ toppers in the class. 

(a) an; the 

(b) a; an 

(c) a; the 

(d) the; a 

Ans.(c) 

Sol. The correct option is (c). 

In the first blank, we need the indefinite article before “very intelligent girl.” Although “intelligent” begins 

with a vowel sound, the article depends on the first pronounced sound after the article. Here the phrase is “a 

very intelligent girl” because the word immediately after the article is “very”, which begins with a consonant 

sound /v/. Hence, “a” is correct. 

In the second blank, “one of ____ toppers” refers to a specific group (the toppers of the class), so the definite 

article “the” is used: “one of the toppers.” 

Example: He is a very honest man and one of the best teachers in the school. 

Why other options are incorrect: 

• Option (a) an; the: “An very” is incorrect because “very” starts with a consonant sound. 

• Option (b) a; an: “one of an toppers” is grammatically incorrect; “one of” requires “the” with a defined 

group. 

• Option (d) the; a: “the very intelligent girl” would indicate a specific girl already known, which is not 

implied; also “one of a toppers” is incorrect. 

“So the correct answer is (c)” 

 

Q4. Convert the sentence provided below from its passive voice structure to an active voice structure: 

The final draft has been approved by the committee. 

(a) The committee has been approving the final draft. 

(b) The committee has approved the final draft. 

(c) The committee is approving the final draft. 

(d) The committee approved the final draft. 

Ans.(b) 

Sol. The correct option is (b). 

Explanation: 

The sentence is in present perfect passive: “has been approved”. To convert passive to active while keeping 

the same tense, we change it to present perfect active: “has approved”. 

Rules for conversion: 

• Agent after by becomes the subject: the committee. 

• Keep tense same: has been approved (passive) becomes has approved (active). 

• Object becomes the object in active: the final draft. 

Structure: 

Passive voice: Object + has/have been + V3 + by + Subject. 

Active voice: Subject + has/have + V3 + Object. 

Why other options are incorrect: 
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• (A) present perfect continuous; changes tense and meaning. 

• (C) present continuous; changes tense. 

• (D) simple past; changes tense. 

“So the correct answer is (b)” 

 

Q5. One of these words is spelled incorrectly. Which one is it? 

(a) Torpor 

(b) Penury 

(c) Zealot 

(d) Sacriledge 

Ans.(d) 

Sol. The correct option is (d). 

Option (d) is the incorrectly spelt word. The correct spelling is Sacrilege. 

Sacrilege means the act of treating something sacred or holy with disrespect; violation of what is considered 

sacred (Hindi meaning: पतित्रता का अपमान / अपतित्र कृत्य). 

Example: Many people considered the destruction of the shrine an act of sacrilege. 

Meanings of all the given options: 

• A: Torpor – a state of physical or mental inactivity; sluggishness (Hindi meaning: सुस्ती / जड़ता). 

• B: Penury – extreme poverty; destitution (Hindi meaning: अत्यतिक गरीबी). 

• C: Zealot – a person who is fanatically devoted to a cause or belief (Hindi meaning: कट्टर समथथक / उग्र 

अनुयायी). 

• D: Sacriledge – incorrect spelling; correct word is “sacrilege” (Hindi meaning: पतित्रता का अपमान). 

Parts of speech note: “Sacrilege” is a noun (an act/instance of disrespect to sacred things). 

So the correct answer is (d) 

 

Q6. Select the most appropriate option to fill in the blanks. 

My _____ gave me a beautiful _____ for my birthday. 

(a) sister; advice 

(b) doctor; medicine 

(c) teacher; homework 

(d) friend; gift 

Ans.(d) 

Sol. The correct option is (d). 

The sentence talks about a person who gave something beautiful on a birthday. The most natural and 

contextually suitable collocation is “friend; gift”, because a gift is commonly given on birthdays, and a friend 

is a likely giver in such a context. 

Hindi meaning: friend = (तमत्र / दोस्त), gift = (उपहार / तोहफा). 

Example: My friend gave me a wonderful gift on my birthday. 

Why other options are incorrect: 

• Option (a) sister; advice: “Advice” is not typically described as “beautiful,” and it does not fit naturally 

with birthday giving in this sentence. 

• Option (b) doctor; medicine: A doctor usually prescribes medicine; it is not a “beautiful” birthday item. 
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• Option (c) teacher; homework: Homework is not given as a birthday present and cannot be described as 

“beautiful” in a normal sense. 

“So the correct answer is (d)” 

 

Q7. Choose the correct part of speech for the highlighted word in each sentence. 

The cat quickly jumped over the fence. 

(a) Adverb 

(b) Verb 

(c) Adjective 

(d) Noun 

Ans.(a) 

Sol. The correct option is (a). 

In the given sentence, the highlighted word quickly tells us how the action was performed. It modifies the 

verb jumped by showing the manner of jumping; therefore, it functions as an adverb. 

Step-by-step reasoning: 

• Identify the action (verb) in the sentence: jumped. 

• Ask the question: How did the cat jump? The answer is quickly. 

• Words that answer how/when/where/to what extent about a verb are adverbs. 

Why other options are incorrect: 

• Verb: A verb shows an action or state (jump, run, is). Quickly is not an action; it describes the action. 

• Adjective: An adjective describes a noun/pronoun (quick cat). Here, quickly does not describe cat; it 

describes jumped. 

• Noun: A noun names a person/place/thing/idea. Quickly is not a naming word. 

So the correct answer is (a) 

 

Q8. A sentence is provided in direct speech. From the four given options, choose the one that most accurately 

conveys the sentence in its corresponding indirect speech. 

Meera said, "I can finish the task today." 

(a) Meera said that she can finish the task today. 

(b) Meera said that I could finish the task that day. 

(c) Meera said that she could finish the task that day. 

(d) Meera said she will finish the task today. 

Ans.(c) 

Sol. The correct option is (c). 

Explanation: To convert direct speech into indirect speech, we apply the rules of narration: 

• The reporting verb is said (past), so the tense generally shifts back (if the statement is not a universal truth). 

• Pronoun changes: “I” (Meera speaking) becomes she. 

• Modal change: can becomes could. 

• Time expression change: today becomes that day. 

Thus, the correct indirect speech is: Meera said that she could finish the task that day. 

Why other options are incorrect: 

• A: “can” and “today” are not changed; with a past reporting verb, “can” should become “could” and 

“today” should become “that day”. 
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• B: Uses “I” incorrectly; it should change to “she”. 

• D: “will” is not the correct backshift from “can” and “today” remains unchanged. 

So the correct answer is (c) 

 

Q9. Find the part of the sentence that contains an error: 

The researcher’s summary (1)/ was fill with precision (2)/ yet managed to obscure (3)/ more than clarify. (4)/ 

(a) (1) 

(b) (2) 

(c) (3) 

(d) (4) 

Ans.(b) 

Sol. The correct option is (b). 

Explanation of the error: 

Part (2) has the phrase: “was fill with precision”. Here, “was” indicates a passive construction, so it must be 

followed by past participle (V3). The correct form is “was filled with precision”, not “was fill”. 

Correct sentence: 

The researcher’s summary was filled with precision, yet managed to obscure more than clarify. 

Grammatical rule used: 

In passive voice, the structure is be verb + past participle (V3). 

Examples: “The work was completed on time.” / “The forms were signed by the officer.” 

Why other parts are correct: 

• (1) “The researcher’s summary” is a correct noun phrase. 

• (3) “yet managed to obscure” is grammatically correct and shows contrast. 

• (4) “more than clarify” is parallel and correct in comparison structure. 

Information booster: After “was/were/is/are/has been/have been/had been”, always check whether a V3 form 

is required (passive or perfect passive). 

“So the correct answer is (b)” 

 

Q10. Select the most appropriate homophone of the italicised word. 

The thief tried to steal the bike. 

(a) Steele 

(b) Steel 

(c) Stale 

(d) Stell 

Ans.(b) 

Sol. The correct homophone of the given word is (b) Steel. 

‘Steal’ means to take something illegally without permission, while ‘steel’ is a metal; both are pronounced the 

same (/stiːl/), so steel is the correct homophone. (Steal = चुराना, Steel = इस्पात/स्टील) 

Example: Thieves often steal bikes from crowded streets, and the bikes are usually made of steel. 

Meanings of the given other options: 

• (a) Steele: A surname/proper noun (नाम/उपनाम) 

• (c) Stale: Not fresh; dull/old (बासी/फीका) 

• (d) Stell: Not a standard/common English word in this context (मानक शब्द नही ां) 
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Q11. Select the most appropriate synonym of the given word. 

Obscure 

(a) Wild 

(b) Sane 

(c) Arrogant 

(d) Ambiguous 

Ans.(d) 

Sol. The correct option is (d). 

The word “obscure” means something that is not clear, not easily understood, or hidden from view. It can also 

refer to something unknown or not well-known. Hence, the closest synonym among the options is 

“ambiguous”, which means unclear or having more than one possible meaning. 

Obscure (given word) meaning (2+ lines): “Obscure” refers to something that lacks clarity and is difficult to 

understand or perceive. It may also indicate something hidden, dim, or not widely known. 

Hindi meaning: (अस्पष् / िुांिला / अप्रतसद्ध). 

Example: The instructions were obscure, so many students made mistakes. 

Ambiguous (correct answer): “Ambiguous” means not having one clear meaning; it can be interpreted in more 

than one way. It creates confusion because it is not definite or precise. 

Hindi meaning: (तििापूर्थ / अस्पष्). 

Example: His ambiguous reply left everyone uncertain about the decision. 

Synonyms: unclear, vague, indistinct, hidden. 

Antonyms: clear, obvious, explicit, definite. 

Meanings of all the other given options: 

• Option (a) Wild: uncontrolled; untamed (जांगली / बेकाबू). 

• Option (b) Sane: mentally sound; reasonable (समझदार / होश में). 

• Option (c) Arrogant: overly proud; having excessive self-importance (अहांकारी / घमांडी). 

“So the correct answer is (d)” 

 

Q12. Select the correct option: 

The artefact was admired not just for its antiquity but also for the ___ with which it was maintained. 

(a) severity 

(b) brevity 

(c) meticulousness 

(d) veracity 

Ans.(c) 

Sol. The correct option is (c). 

Explanation: 

The sentence says the artefact was admired not only for being old (antiquity) but also for the way it was 

maintained. The blank needs a word that means great care, precision, and attention to detail in maintenance. 

Meticulousness means the quality of being very careful and exact in doing something. (Hindi meaning: बारीकी 

से साििानी / सूक्ष्मता) Hence, it fits perfectly with “maintained”. 

Example: 
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The museum praised the meticulousness with which the curator preserved the ancient manuscripts. 

Why other options are incorrect: 

• Option (a) severity: Means strictness or harshness. (Hindi: कठोरता) This does not suit the idea of careful 

maintenance. 

• Option (b) brevity: Means shortness in duration or expression. (Hindi: सांतिप्तता) It has no relation to 

maintaining an artefact. 

• Option (d) veracity: Means truthfulness or accuracy of statements. (Hindi: सत्यता) Not related to 

maintenance. 

So the correct answer is (c) 

 

Q13. Convert the sentence provided below from its passive voice structure to an active voice structure: 

The compliance report has been filed by the legal unit after several revisions. 

(a) The legal unit filed the compliance report after several revisions. 

(b) The legal unit is filing the compliance report after several revisions. 

(c) The legal unit has filed the compliance report after several revisions. 

(d) The legal unit had filed the compliance report after several revisions. 

Ans.(c) 

Sol. The correct option is (c). 

Explanation: 

The given sentence is in passive voice: “has been filed”. The tense is present perfect passive because it uses 

has been + V3. 

Rules for conversion (Passive to Active): 

• Identify the agent introduced by “by” (here, the legal unit) and make it the subject. 

• Keep the same tense: present perfect becomes has/have + V3 in active. 

• Move the object (here, the compliance report) after the verb as the object. 

Structure: 

Passive voice: Object + has/have been + V3 + by + Subject. 

Active voice: Subject + has/have + V3 + Object. 

Therefore: “The legal unit has filed the compliance report after several revisions.” 

Why other options are incorrect: 

• (A) changes the tense to simple past. 

• (B) changes the tense to present continuous. 

• (D) changes the tense to past perfect. 

“So the correct answer is (c)” 

 

Q14. Rearrange the following sentences in correct order to make a meaningful passage. 

1. Indicators are reviewed by dedicated monitoring units at regular intervals. 

2. The model is repeatedly refined through multi-stakeholder consultations. 

3. Deviations from targets are recorded on real-time dashboards. 

4. Data systems are redesigned to improve inclusion. 

(a) 1-2-3-4 

(b) 1-3-4-2 

(c) 2-4-3-1 
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(d) 3-2-4-1 

Ans.(b) 

Sol. The correct option is (b). 

Explanation of the correct order (1-3-4-2): 

• Sentence 1 sets the monitoring framework: indicators are reviewed regularly. This establishes the process. 

• Sentence 3 naturally follows because monitoring leads to noting outcomes, and deviations are recorded on 

dashboards for visibility. 

• Sentence 4 comes next as an action step taken after observing issues: data systems are redesigned to 

improve inclusion. 

• Sentence 2 is best at the end because refining the model through multi-stakeholder consultations is an 

ongoing improvement step that logically follows system redesign and evidence from monitoring. 

Grammar/logic clue: A coherent passage often moves from observation (review/record) to intervention 

(redesign) and then to continuous improvement (refine through consultations). 

“So the correct answer is (b)” 

 

Q15. A sentence is provided in direct speech. From the four given options, choose the one that most accurately 

conveys the sentence in its corresponding indirect speech. 

He said, “I may finish the task today.” 

(a) He said that he will finish that task that day. 

(b) He said that he might finish this task today. 

(c) He said that he might finish that task that day. 

(d) He said he may finish the task today. 

Ans.(c) 

Sol. The correct option is (c). 

Explanation: 

The given sentence is in Direct Speech: He said, “I may finish the task today.” 

Since the reporting verb is in the past (said), we generally apply backshift of tense/modals in Indirect Speech. 

Rules applied: 

• Pronoun change: I changes to he (as per the subject of reporting verb). 

• Modal change: may changes to might in reported speech when reporting verb is past. 

• Time expression change: today changes to that day. 

• Demonstrative change: the task can remain as it is, but to maintain standard indirect speech, that task is 

preferred. 

Therefore: He said that he might finish that task that day. 

Why other options are incorrect: 

• Option (a): Uses will, which does not correctly represent may and also changes meaning (certainty instead 

of possibility). 

• Option (b): Keeps this and today, which are usually changed to that and that day in indirect speech. 

• Option (d): Keeps may and today; it does not follow backshift rules when reporting verb is past. 

So the correct answer is (c) 
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Q16. Select the most appropriate synonym of the given word: LOQUACIOUS 

(a) Talkative 

(b) Reticent 

(c) Mute 

(d) Hear 

Ans.(a) 

Sol. The correct option is (a). 

The word LOQUACIOUS means very talkative; someone who speaks a lot, often more than necessary. It is 

commonly used for people who are fluent and continuously speaking. (Hindi meaning: बातूनी/अतिक बोलने 

िाला). 

Example (given word): The loquacious guest dominated the entire conversation at the dinner table. 

The synonym that matches this meaning is Talkative, which means inclined to talk a lot; fond of conversation. 

(Hindi meaning: बातूनी). 

Example (correct synonym): She is talkative and easily makes friends in a new place. 

Synonyms: garrulous, chatty, verbose, communicative. 

Antonyms: reticent, taciturn, silent, reserved. 

Meanings of the other options: 

• B: Reticent – not revealing one’s thoughts; quiet and reserved (Hindi: सांकोची/कम बोलने िाला). 

• C: Mute – unable to speak; silent (Hindi: गूांगा/मौन). 

• D: Hear – perceive sound; listen (Hindi: सुनना). 

So the correct answer is (a) 

 

Q17. Choose the most suitable option to replace the highlighted part of the sentence: 

By the time we arrived at the venue, the speaker began the session. 

(a) had begun 

(b) has begun 

(c) was beginning 

(d) is beginning 

Ans.(a) 

Sol. The correct option is (a). 

Explanation: 

The sentence begins with “By the time we arrived ...”, which clearly shows that one past action happened 

before another past action. The arrival happened in the past, and the session started before that arrival. To 

show the earlier past action, we use past perfect. 

Grammatical rule used: 

When two actions occurred in the past and we want to show the earlier one, use: 

Past perfect (had + V3) for the earlier action + simple past for the later action. 

Correct sentence: 

By the time we arrived at the venue, the speaker had begun the session. 

Example: By the time the train arrived, the passengers had left the platform. 

Why other options are incorrect: 

• (B) has begun: Present perfect does not fit with a completed past time context (“arrived”). 
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• (C) was beginning: Past continuous does not clearly show completion before arrival. 

• (D) is beginning: Present continuous is incorrect with the past time frame. 

Information booster: Common time markers for past perfect: “by the time,” “already,” “before,” “after,” 

“when” (in certain past sequences). 

“So the correct answer is (a)” 

 

Q18. Find the part of the sentence that contains an error: 

He had never visited (1)/ such a renowned exhibition (2)/ until he (3)/ visits the museum last winter. (4)/ 

(a) (1) 

(b) (2) 

(c) (3) 

(d) (4) 

Ans.(d) 

Sol. The correct option is (d). 

Explanation of the error: 

Part (4) says: “visits the museum last winter”. The time expression “last winter” refers to a completed action 

in the past, so the verb must be in simple past: visited, not visits. 

Correct sentence: 

He had never visited such a renowned exhibition until he visited the museum last winter. 

Grammatical rule used: 

When a sentence includes a definite past time marker (yesterday, last year, last winter, in 2019), we use simple 

past. 

Example: “She met him last week.” (Not “meets”) 

Information booster: “Had never visited ... until ...” often uses past perfect in the first clause and simple past 

in the second clause to show the later past event that changed the situation. 

“So the correct answer is (d)” 

 

Q19. Select the most appropriate meaning of the given idiom. 

Butterflies in one's stomach 

(a) To experience sleepiness 

(b) To enjoy a delicious meal 

(c) To have nervousness or anxiety 

(d) To feel hungry 

Ans.(c) 

Sol. The correct option is (c). 

The idiom “butterflies in one’s stomach” means feeling nervous, anxious, or excited, especially before an 

important event such as an exam, interview, or performance. It describes a fluttery sensation in the stomach 

caused by tension or anticipation. 

Hindi meaning (idiom): (पेट में घबराहट / घबराहट होना). 

Example: Before the interview, I had butterflies in my stomach. 

Why other options are incorrect: 

• Option (a): Sleepiness is unrelated to nervousness or anxiety. 

• Option (b): Enjoying a meal refers to satisfaction, not anxiety. 
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• Option (d): Hunger is a physical need, but the idiom refers to an emotional state. 

Other related idioms and their meanings: 

• Get cold feet: to become nervous and hesitate. 

• On edge: feeling tense or nervous. 

• Heart in one’s mouth: feeling very anxious or frightened. 

• Break into a cold sweat: to sweat due to fear or anxiety. 

“So the correct answer is (c)” 

 

Q20. Fill in the blank with the most appropriate option: 

Among all the debaters in the final round, Meera was judged the ___ in logical reasoning. 

(a) best 

(b) better 

(c) most better 

(d) more best 

Ans.(a) 

Sol. The correct option is (a). 

Step-by-step reasoning (Fill in the blank - Degree of comparison): 

• Key phrase: “Among all the debaters” indicates comparison with the entire group, so we need the 

superlative degree. 

• Superlative of “good”: good → better (comparative) → best (superlative). 

• Sentence correctness: “Meera was judged the best in logical reasoning” is grammatically and contextually 

correct because it shows she ranked highest in the group. 

Why other options are incorrect: 

• (b) better is comparative and is used for comparing two persons/things, not “among all.” 

• (c) most better is a double comparison (incorrect structure) because “better” itself is already comparative. 

• (d) more best is also a double comparison (incorrect) because “best” is already superlative. 

So the correct answer is (a) 

 

Q21. Choose the correct one-word substitute for: 

A strong and unreasonable fear of something 

(a) Phobia 

(b) Earthquake 

(c) Tsunami 

(d) Outbreak 

Ans.(a) 

Sol. Explanation: A strong, irrational, and unreasonable fear of something is called a phobia (Hindi meaning: 

भय/फोतबया). It is used for intense fear that may not match the real level of danger, such as fear of heights, 

spiders, or closed spaces. 

Example: His phobia of dogs made it difficult for him to visit friends who had pets. 

Meanings of other options: 

• Option B (Earthquake): shaking of the Earth due to tectonic movement (Hindi: भूकां प). 

• Option C (Tsunami): very large sea waves caused by underwater disturbance (Hindi: सुनामी). 

• Option D (Outbreak): sudden start/spread of disease or violence (Hindi: प्रकोप / फैलाि). 
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“So the correct answer is (a)” 

 

Q22. Select the most appropriate ANTONYM of the given word. 

Accord 

(a) Disrespect 

(b) Welcome 

(c) Disagreement 

(d) Conformity 

Ans.(c) 

Sol. The correct antonym of the given word is (c) Disagreement. 

Accord: Accord means agreement, harmony, or a formal settlement/understanding between people or groups. 

(Hindi: सहमतत / मेल-तमलाप / समझौता) 

It indicates unity of opinion and peaceful consent. 

Example: The two parties reached an accord after long negotiations. 

Disagreement: Disagreement means difference of opinion, lack of harmony, or not being in agreement. (Hindi: 

असहमतत / मतभेद) 

It is the opposite of accord because it shows conflict of views rather than harmony. 

Example: There was disagreement among the members about the plan. 

Synonyms (of Accord): agreement, harmony, settlement, concurrence 

Antonyms (of Accord): disagreement, conflict, discord, dispute 

Meanings of all the other given options: 

• Option (a) Disrespect: lack of respect; rude behaviour (Hindi: अनादर / अपमान) 

• Option (b) Welcome: to greet/receive gladly (Hindi: स्वागत करना) 

• Option (d) Conformity: compliance with rules/standards (Hindi: अनुरूपता / तनयम-पालन) 

 

Q23. Select the most appropriate antonym of the given word. RECOUNT 

(a) Narrate 

(b) Conceal 

(c) Retell 

(d) Describe 

Ans.(b) 

Sol. The correct option is (b). 

Explanation: 

Recount means to tell or narrate something in detail, especially an event or story. (Hindi meaning: िर्थन करना 

/ घटनाएँ सुनाना) 

The antonym should convey the opposite idea: not telling, but hiding information. Conceal means to hide or 

keep something secret. (Hindi meaning: तिपाना) 

Example (given word): He recounted his travel experiences to the audience. 

Example (antonym): She concealed the facts to avoid criticism. 

Synonyms (Recount): narrate, relate, retell, recite. 

Antonyms (Recount): conceal, hide, suppress, withhold. 

Meanings of the other options: 
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• (A) Narrate: To tell a story. (Hindi: कहानी सुनाना) 

• (C) Retell: To tell again. (Hindi: तफर से बताना) 

• (D) Describe: To give details of something. (Hindi: तििरर् देना) 

“So the correct answer is (b)” 

 

Q24. Choose the correct meaning of idiom given below: 

“Jump on the bandwagon” 

(a) Avoid public attention 

(b) Join a popular trend 

(c) Argue without evidence 

(d) Delay a decision 

Ans.(b) 

Sol. The correct option is (b). 

Meaning and usage of the idiom: 

• Idiom: “Jump on the bandwagon” 

• Meaning (in context): It means to join or support something because it is becoming popular, often to gain 

acceptance or benefit, rather than from genuine belief. 

• Hindi meaning: “लोकतप्रय िारा में शातमल हो जाना / भीड़ के साथ चल पड़ना।” 

• Example sentence: “After the new app became famous, many people jumped on the bandwagon and started 

promoting it.” 

Why option (b) is correct: 

• “Join a popular trend” matches the established meaning of the idiom exactly. 

Why other options are incorrect: 

• (a) is the opposite idea; the idiom suggests joining what is popular, not avoiding attention. 

• (c) refers to arguing without proof, which is not related to following a trend. 

• (d) means postponing a decision, which is unrelated to joining popularity. 

Other related idioms and meanings: 

• Follow the crowd: to do what most people do. 

• Go with the flow: to accept things as they happen without resisting. 

• Toe the line: to obey rules or follow authority (not exactly the same, but related to conformity). 

So the correct answer is (b) 

 

Q25. Select the correctly spelt word meaning ‘a person who doubts accepted beliefs’. 

(a) Skepptic 

(b) Skeptic 

(c) Scaeptic 

(d) Skiptic 

Ans.(b) 

Sol. The correct option is (b). 

Step-by-step reasoning (Correctly spelled word): 

• We must select the correctly spelt word that means “a person who doubts accepted beliefs.” 

• Correct spelling: Skeptic. 
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• Meaning of “Skeptic”: a person who doubts or questions commonly accepted opinions or claims; one who 

does not easily believe without proof. (Hindi: “सांदेहिादी / सांशयिादी”) It is used as a noun. 

• Example sentence: “As a skeptic, she demanded strong evidence before accepting the claim.” 

Meanings of all the given options: 

• (a) Skepptic: incorrect spelling; intended word is “Skeptic” (Hindi: “सांदेहिादी”). 

• (b) Skeptic: correct spelling; a doubter (Hindi: “सांदेहिादी / सांशयिादी”). 

• (c) Scaeptic: incorrect spelling; not a standard English word. 

• (d) Skiptic: incorrect spelling; not a standard English word. 

Parts of speech note: “Skeptic” is a noun (person). Its adjective form is “skeptical” (Hindi: “सांदेहपूर्थ”). 

So the correct answer is (b) 

 

Q26. The value of 54+(11+47)−3445+1+741−43is 

(a) 29/32 

(b) 35/12 

(c) 25/22 

(d) 28/19 

Ans.(c) 

Sol. Given:  

54+(11+47)−3445+(1+741)−43 

Solution:  

54+(11+47)−34=54+(17+47)−34=54+(711)−34=24+(711)=22+2844=5044=252245+(1+741)−43=45+(77+4

1)−43=45+(117)−43=42+(117)=4422+28=4450=2225 

 

Q27. In ∆ABC, BD ⊥ AC at D and ∠DBC = 390. E is a point on BC such that ∠CAE = 160. What is the 

measure of ∠AEB? 

(a) 820 

(b) 660 

(c) 670 

(d) 740 

Ans.(c) 

Sol. Given: 

In ∆ABC, BD ⟂ AC at D and ∠DBC = 39° 

E is a point on BC such that ∠CAE = 16° 

Find ∠AEB. 

Solution: 
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Since BD ⟂ AC and ∠DBC = 39°, the angle at C (between BC and AC) is 

∠BCA = 90° − 39° = 51°. 

∠CAE = 16° so the line AE makes 16° with AC. 

Therefore the angle at E between AE and BC is 

∠AEB = ∠BCA + ∠CAE = 51° + 16° = 67°. 

 

Q28. A sum of Rs. 625 amounts to Rs. 841 in 2 years at a certain rate of interest per annum, compounded 

annually. The rate of interest per annum is: 

(a) 18% 

(b) 19% 

(c) 16% 

(d) 17% 

Ans.(c) 

Sol. Given: 

Principal, P = ₹625 

Amount after 2 years, A = ₹841 

Interest is compounded annually. 

Find rate, R % 

Concept Used: 

Compound Interest (CI) formula for annual compounding: 

A = P(1+R100)TP(1+100R)T 

Solution: 

841=625(1+R100)2(1+R100)2=841625(1+R100)2=(2925)21+R100=2925R100=2925−1=425R=100×425=1

6841=625(1+100R)2(1+100R)2=625841(1+100R)2=(2529)21+100R=2529100R=2529−1=254R=100×254

=16 

Thus, Rate of interest = 16% per annum 

Alternate Solution(Exam Hall Method):  
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Q29. 2 years ago, the age of a father was 22 years more than twice his sons age. After how many years, from 

now, will he be twice his sons age? 

(a) 17 

(b) 16 

(c) 21 

(d) 20 

Ans.(d) 

Sol. Given: 

2 years ago, father’s age = 2 × son’s age + 22. 

Find after how many years from now the father will be twice the son's age. 

Solution: 

Let present age of son = s 

Let present age of father = f 

Given condition (2 years ago): 

f - 2 = 2(s - 2) + 22 

f - 2 = 2s - 4 + 22 

f - 2 = 2s + 18 

f = 2s + 20 

Future condition: 

f + x = 2(s + x) 

Substitute ( f = 2s + 20 ): 

2s + 20 + x = 2s + 2x 

➔ x = 20 

So, after 20 years, the father will be twice the son's age. 

Alternate Solution (Exam Trick): 

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


 
 

 
 

Q30. A cylindrical rod has an outer curved surface area of 1500 cm2. If the length of the rod is 68 cm, then 

the outer radius in cm of the rod, correct to two places of decimal, is : (Take π = 22/7) 

(a) 3.51 

(b) 6.61 

(c) 3.87 

(d) 3.69 

Ans.(a) 

Sol. Given: 

Outer curved surface area (CSA) of cylinder = 1500 cm2 

Length (height) h = 68 cm 

Formula Used: 

Curved Surface Area of a cylinder = 2πrh2πrh 

Solution: 

1500=2×227×68×r1500=29927rr=1500×72992r=105002992≈3.51cm1500=2×722×68×r1500=72992

rr=29921500×7r=299210500≈3.51 cm 

 

Q31. What is the median of the following data? 

57, 96, 60, 91, 69, 50, 72, 16, 78, 73, 55 

(a) 70 

(b) 69.5 

(c) 69 

(d) 68.5 

Ans.(c) 

Sol. Given: 

Data: 57, 96, 60, 91, 69, 50, 72, 16, 78, 73, 55 

Concept Used: 

Median of ungrouped data = Middle term after arranging data in ascending order. 

For n = odd number of terms, 

Median = (n+12)th term(2n+1)th term 
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Solution: 

Arrange data in ascending order: 

16, 50, 55, 57, 60, 69, 72, 73, 78, 91, 96 

Median term position = \frac{11 + 1}{2} = 6th term 

6th term = 69 

Median = 69 

 

Q32. An item is marked at Rs. 8,000. Two successive discounts of 10% and 15% are allowed. Find the 

equivalent single discount rate. 

(a) 23.5% 

(b) 22.5% 

(c) 25.5% 

(d) 24.5% 

Ans.(a) 

Sol. Given: 

Marked Price = ₹8000 

Successive discounts = 10% and 15% 

Find the equivalent single discount rate. 

Concept Used: 

Successive discount formula: 

Net Discount = A + B - AB100100AB 

Solution: 

Single Discount = 10 + 15 - 10×1510010010×15 

= 25 - 1.5 = 23.5% 

Equivalent single discount = 23.5% 

 

Q33. Pipe A can fill a tank in 17 hours, pipe B can fill the same tank in 21 hours and pipe C can fill the same 

tank in 19 hours. The time taken by them to fill the same tank if they operate together is: 

(a) 133091079hours131079309hours 

(b) 53091079hours51079309hours 

(c) 63091079hours61079309hours 

(d) 113091079hours111079309hours 

Ans.(c) 

Sol. Given: 

Pipe A fills tank in 17 hr 

Pipe B fills tank in 21 hr 

Pipe C fills tank in 19 hr 

Solution: 

1T=117+121+1191T=401+324+35868071T=10836807⟹T=68071083=63091079hT1=171+211+191T1

=6807401+324+358T1=68071083⟹T=10836807=61079309h 

Exam Hall Method: 
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Q34. Find the value of 5−23×16−23×21−235−23×16−23×21−23 

(a) 11725231725231 

(b) 11680231680231 

(c) 11726231726231 

(d) 11634231634231 

Ans.(b) 

Sol. Given: 

Evaluate: 5−23×16−23×21−235−23×16−23×21−23 

Concept Used: 

Laws of Indices — a−n=1ana−n=an1 

a−n×b−n×c−n=(abc)−na−n×b−n×c−n=(abc)−n 

Solution: 

5−23×16−23×21−235−23×16−23×21−23 

= (5×16×21)−23(5×16×21)−23 

= 1680−231680−23 

= 11680231680231 

 

Q35. One-third of a journey is covered at a speed of 2 kmhr, the next one-third of the journey is covered at a 

speed of 87 kmhr and the remaining journey is covered at a speed of 53 kmhr. The average speed in kmhr, 

rounded off to 1 decimal place for the entire journey is 

(a) 2.7 

(b) 5.7 

(c) 8.3 

(d) 5 

Ans.(b) 

Sol. Given: 

A journey divided into 3 equal parts: 

1st part at 2 km/h 

2nd part at 87 km/h 

3rd part at 53 km/h 

Find the average speed for the entire journey. 

Concept Used: 
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When a journey is divided into equal distances with different speeds, 

Average Speed = 31v1+1v2+1v3v11+v21+v313 

Solution: 

vavg=312+187+153=34611+106+1749222=348919222=3×92224891≈5.7km/hvavg=21+871+5313

=92224611+106+1743=922248913=48913×9222≈5.7km/h 

Alternate Solution (Exam Trick): 

 
 

Q36. Simplify: 2((32)x2−25x+14)−3(x2+4x−13)2((23)x2−25x+14)−3(x2+4x−13). 

(a) 62x-67 

(b) -62x-67 

(c) -62x+67 

(d) 62x+67 

Ans.(c) 

Sol. Given:  

2((32)x2−25x+14)−3(x2+4x−13)2((23)x2−25x+14)−3(x2+4x−13) 

Solution:  

2((32)x2−25x+14)−3(x2+4x−13)=3x2−50x+28−3x2−12x+39=3x2−50x+28−3x2−12x+39=−62x+672((23

)x2−25x+14)−3(x2+4x−13)=3x2−50x+28−3x2−12x+39=3x2−50x+28−3x2−12x+39=−62x+67 

 

Q37. The value of 196+0.0324−6.76=196+0.0324−6.76= 

(a) 16.44 

(b) 11.58 

(c) 4.64 

(d) 2.41 

Ans.(b) 

Sol. Given:  

196+0.0324−6.76=196+0.0324−6.76= 

Solution:  

196+0.0324−6.76=14+0.18−2.6=14.18−2.6=11.58196+0.0324−6.76=14+0.18−2.6=14.18−2.6=11.58 
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Q38. Find the least number of square tiles required to completely cover a floor of dimensions 12.15 m by 

11.34 m. 

(a) 230 

(b) 150 

(c) 210 

(d) 250 

Ans.(c) 

Sol. Given: 

Floor dimensions: 12.15 m by 11.34 m 

Formula Used: 

side of largest square tile = HCF(length, breadth) 

number of tiles = (length × breadth) / (side²) 

Solution: 

Convert to centimeters to avoid decimals: 

12.15 m = 1215 cm, 11.34 m = 1134 cm. 

HCF(1215, 1134): 

1215 − 1134 = 81 → HCF(1215,1134) = HCF(1134,81) 

1134 ÷ 81 = 14 exactly, so HCF = 81 cm = 0.81 m 

Side of largest square tile = 81 cm. Tile area = 81² = 6561 cm² 

Number of tiles = (1215×1134)65616561(1215×1134) 

= 121581×113481811215×811134 = 15 × 14 = 210 

= 210 tiles 

Alternate Solution (exam-trick): 

 
 

Q39. The marked price of a watch is Rs. 2,860. A man bought the watch for Rs. 2,390.96, after getting two 

successive discounts, one of which is 12%. What is rate of the other discount? 

(a) 8% 

(b) 7% 

(c) 5% 

(d) 6% 

Ans.(c) 

Sol. Given: 

Marked Price (MP) = Rs. 2860 
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Selling Price (SP) = Rs. 2390.96 

Two successive discounts: 12% and x% 

Concept Used: 

Successive discount formula: 

SP = MP×(1−d1)×(1−d2)×(1−d1)×(1−d2) 

Solution: 

First apply 12% discount: 

2860×0.88=2516.82860×0.88=2516.8 

Now, 

2390.96 = 2516.8(1 - x) 

1-x = 2390.962516.82516.82390.96 

1-x = 0.949999≈0.950.949999≈0.95 

x = 1 - 0.95 = 0.05 

x = 5% 

Alternate Solution (SSC Trick): 

 
 

Q40. In an election between two candidates 80% of the registered voters cast their vote and 15% of the votes 

polled were found invalid. The winning candidate got 60% of the valid votes and won the election by a margin 

of 1394 votes. How many voters were registered? 

(a) 10251 

(b) 10250 

(c) 10252 

(d) 10248 

Ans.(b) 

Sol. Given: 

Let total registered voters = N 

80% voters cast vote → votes polled = 0.8N 

15% of votes polled were invalid 

Winning candidate got 60% of valid votes 

Margin of victory = 1394 votes 

Solution: 

Invalid votes = 0.15 × 0.8N = 0.12N 

Valid votes = 0.8N - 0.12N = 0.68N 

Margin = 20% of valid votes 
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0.20 × 0.68N = 1394 

0.136N = 1394 

N = 13940.1360.1361394 

N = 10250 

Thus, 10,250 registered voters 

Alternate Solution (Exam Trick): 

 
 

Q41. If the third proportional of 9 and 57 be x, then what is the value of x? 

(a) 363 

(b) 361 

(c) 358 

(d) 364 

Ans.(b) 

Sol. Given: 

the third proportional of 9 and 57 

Concept Used: 

If ( a : b = b : c ), then c is the third proportional to a and b 

Formula Used: 

ab=bx=>x=b2aba=xb=>x=ab2 

Solution: 

x = 57299572 

x = 3249993249 = 361 

 

Q42. A man driving a car at a speed of 84 km/hr crosses a bridge in 1.6 minutes. Find the length of the bridge. 

(a) 2.24 km 

(b) 1.81 km 

(c) 2.46 km 

(d) 1.82 km 

Ans.(a) 

Sol. Given: 

Speed of car = 84 km/h 

Time to cross bridge = 1.6 minutes 
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Find: Length of the bridge 

Formula Used: 

Distance covered = Speed × Time 

Solution: 

Distance = 84×518×9684×185×96 = 2240 m 

Thus, Length of the bridge = 2240 metres = 2.24 km 

 

Q43. By selling an article at 4/14 of its actual selling price, Akash incurs a loss of 30%. If he sells it at 54% 

of its actual selling price, then the profit percentage is: 

(a) 34.8 

(b) 32.6 

(c) 33.8 

(d) 32.3 

Ans.(d) 

Sol. Given: 

SP1SP1 = 414×ASP144×ASP 

Loss on SP1SP1 = 30% 

SP2SP2= 54%××ASP 

Find: Profit % on selling at SP2SP2 

Formula Used: 

CP = SP×100100−Loss%SP×100−Loss%100 

Profit% = SP2−CPCP×100CPSP2−CP×100 

Solution: 

Let Actual Selling Price (ASP) = 4900 units 

SP1=414×4900=4×350=1400SP1=144×4900=4×350=1400 

SP1SP1 = 70% of CP 

CP=1400×10070=1400×107=2000CP=1400×70100=1400×710=2000 

SP2SP2 = 54% × 4900 = 54 × 49 = 2646 

Profit = SP2−CPSP2−CP = 2646 - 2000 = 646 

Profit% = 6462000×2000646× 100 = 32.3% 

Alternate Solution: 
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Q44. I bought two speakers for 1,200. I sold the first one at a loss of 8 and the second at a gain of 22. If, on 

the whole I made neither a loss nor a gain, find the cost price in of the first speaker. 

(a) 864 

(b) 900 

(c) 880 

(d) 904 

Ans.(c) 

Sol. Given: 

Two speakers bought for a total of ₹1200. 

First sold at 8% loss 

Second sold at 22% gain 

Net result = no loss, no gain 

Find the cost price of the first speaker. 

Solution: 

Let cost price of first speaker = x 

Then cost price of second speaker = 1200 - x 

Selling prices: 

First → x × (1 - 0.08) = 0.92x 

Second → (1200 - x) × (1 + 0.22) = 1.22(1200 - x) 

Condition: 

Total SP = Total CP = 1200 

0.92x + 1.22(1200 - x) = 1200 

0.92x + 1464 - 1.22x = 1200 

-0.30x + 1464 = 1200 

-0.30x = -264 

x = 2640.300.30264 = 880 

Thus, Cost price of the first speaker = ₹880 

Alternate Solution (Exam Trick): 
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Q45. Sapna invested Rs. 22,400 on simple interest, partly at 13% per annum and partly at 3% per annum. If 

she earns equal interests from the two investments after 7 years, then find the sum invested at 13% per annum 

(in Rs.) 

(a) 4,198 

(b) 4,200 

(c) 4,203 

(d) 4,197 

Ans.(b) 

Sol. Given: 

Sapna invested ₹22,400 partly at 13% p.a. and partly at 3% p.a. on simple interest. 

She earns equal interest from both parts after 7 years. 

Find the amount invested at 13% p.a. 

Formula Used: 

Simple Interest (SI) = P×R×T100100P×R×T 

Given: SI₁ = SI₂ 

Thus, 

P1×R1=P2×R2P1×R1=P2×R2 (since time is same) 

Solution: 

Let the amount invested at 13% = x 

Then amount at 3% = 22,400 - x 

Equal interest condition: 

x × 13 = (22,400 - x) × 3 

13x = 67,200 - 3x 

16x = 67,200 

x = 4,200 

Thus, Amount invested at 13% is ₹4,200 

Alternate Solution (Exam Trick): 

 
 

Q46. Aarti, Anil, and Naveen invest Rs. 1,110, Rs. 1,760, and Rs. 1,230 respectively to start a business. If the 

profit at the end of the year is Rs. 1,620, then what is the share of Naveen in the profit? 

(a) Rs. 487 

(b) Rs. 486 

(c) Rs. 483 
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(d) Rs. 488 

Ans.(b) 

Sol. Given: 

Aarti, Anil, and Naveen invest: 

Aarti = 1110, Anil = 1760, Naveen = 1230 

Total profit = 1620 

Concept Used: 

Partnership → Profit is distributed in the ratio of Capital × Time (all invested for same time) 

Formula Used: 

Naveen's Share = Naveen’s CapitalTotal Capital×Total ProfitTotal CapitalNaveen’s Capital×Total Profit 

Solution: 

Total capital: 

1110 + 1760 + 1230 = 4100 

Naveen’s share: 

12304100×162041001230×1620 

= 310×1620103×1620 

= 486 

Naveen’s share in the profit = Rs. 486 

Alternate Solution (Quick Trick):  

 
 

Q47. Anjani can do a certain piece of work in 24 days. Anjani and Khushbu can together do the same work in 

20 days, and Anjani, Khushbu and Sushmita can do the same work together in 8 days. In how many days can 

Anjani and Sushmita do the same work? 

(a) 57/7 

(b) 61/8 

(c) 60/7 

(d) 54/9 

Ans.(c) 

Sol. Given: 

Anjani alone can do the work in 24 days. 

Anjani + Khushbu can do it in 20 days. 

Anjani + Khushbu + Sushmita can do it in 8 days. 

Find: Time taken by Anjani + Sushmita together. 
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Solution: 

A=124,A+K=120,A+K+S=18A=241,A+K=201,A+K+S=81 

Khushbu’s work rate: 

A+K - A = 120−124201−241 

K = 6−5120=11201206−5=1201 

Sushmita’s work rate: 

(A+K+S) - (A+K) = 18−12081−201 

S = 5−240=340405−2=403 

Anjani + Sushmita’s combined rate: 

A + S = 124+340241+403 

A+S = 5120+9120=14120=7601205+1209=12014=607 

Thus, 

Time = 1A+S=17/60=607A+S1=7/601=760 days 

Alternate Solution (Exam Trick): 

 
 

Q48. Find the area of a triangle whose base is 28 cm and corresponding altitude is 15 cm. 

(a) 280 cm2 

(b) 260 cm2 

(c) 210 cm2 

(d) 240 cm2 

Ans.(c) 

Sol. Given: 

Base of triangle = 28 cm 

Altitude (height) = 15 cm 

Concept Used: 

Area of a triangle = 12×base×height21×base×height 

Solution: 

A = 12×28×1521×28×15 

= 14 × 15 = 210 

Area of the triangle = 210 cm² 
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Q49. A number, when increased by 100%, gives 2790. The number is 

(a) 697.5 

(b) 2790 

(c) 4185 

(d) 1395 

Ans.(d) 

Sol. Given: 

A number, when increased by 100%, becomes 2790. 

Solution: 

If original number = x, 

100% increase => New value = x + x = 2x 

So, 2x = 2790 

x = 2790 ÷ 2 

x = 1395 

 

Q50. The average runs scored by a batsman in 23 matches is 41. In the next 10 matches, the batsman scored 

an average of 15 runs. Find his average runs scored rounded off to two decimal places in all the 33 matches. 

(a) 32.12 

(b) 34.12 

(c) 35.12 

(d) 33.12 

Ans.(d) 

Sol. Given: 

Average of first 23 matches = 41 

Average of next 10 matches = 15 

Total matches = 33 

Find the overall average (rounded to two decimal places). 

Formula Used: 

Total runs = Average1×Matches1Average1×Matches1 + Average2×Matches2Average2×Matches2 

Overall Average = Total runsTotal matchesTotal matchesTotal runs 

Solution: 

Runs in first 23 matches: 

23 × 41 = 943 

Runs in next 10 matches: 

10 × 15 = 150 

Total runs in 33 matches: 

943 + 150 = 1093 

Overall average: 

109333≈33.12331093≈33.12 

Alternate Solution (Exam Trick):  
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Q51. The Lucknow Pact was an agreement between which two major Indian political organisations? 

(a) All-India Muslim League and Communist Party of India 

(b) Indian National Congress and All-India Muslim League 

(c) All-India Muslim League and Hindu Mahasabha 

(d) Indian National Congress and Swaraj Party 

Ans.(b) 

Sol. The correct answer is (B) Indian National Congress and All-India Muslim League 

Explanation: 

• The Lucknow Pact was a historic agreement reached in December 1916 at Lucknow. 

• It was signed between the Indian National Congress (led by Bal Gangadhar Tilak) and the All-India Muslim 

League (led by Muhammad Ali Jinnah). 

• Through this pact, the Congress accepted the Muslim League's demand for separate electorates for Muslims. 

• It showcased Hindu-Muslim unity against British colonial rule. 

Information Booster: 

• Presidents: The Congress session was presided over by Ambika Charan Majumdar. 

• Significance: It also marked the reunion of the Moderate and Extremist factions of the Congress (split since 

Surat 1907). 

• Outcome: It paved the way for the Non-Cooperation and Khilafat Movements. 

Additional Knowledge: 

• Swaraj Party (Option D): Formed much later (1923) by C.R. Das and Motilal Nehru within the Congress. 

• Communist Party (Option A): Was formed in the 1920s, after the Lucknow Pact. 

 

Q52. Grahavarman, who was killed by Shashanka, the king of Bengal, and Devgupta, the later Gupta, was a 

king of which of the following dynasties? 

(a) Pushyabhuti 

(b) Maukhari 

(c) Vakataka 

(d) Maitraka 

Ans.(b) 

Sol. The correct answer is (B) Maukhari 

Explanation: 
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• Grahavarman was a ruler of the Maukhari dynasty which ruled from Kannauj. 

• He was married to Rajyashri, the sister of Harshavardhana (Pushyabhuti dynasty). 

• Grahavarman was treacherously killed by Devgupta (ruler of Malwa) in alliance with Shashanka (ruler of 

Gauda/Bengal). 

• This event triggered Harshavardhana's rise to power as he moved to Kannauj to save his sister and consolidate 

the empire. 

Information Booster: 

• Maukhari Capital: Their capital was Kannauj (Kanyakubja), which later became the political center of North 

India under Harsha. 

• Shashanka: Known as the first independent king of Bengal and a staunch rival of Harsha; he famously cut 

down the Bodhi tree at Bodh Gaya. 

Additional Knowledge: 

• Pushyabhuti (Option A): This was Harsha's dynasty (based in Thanesar). 

• Vakataka (Option C): Ruled in the Deccan; contemporaries of the Guptas. 

• Maitraka (Option D): Ruled in Gujarat (Vallabhi). 

 

Q53. Who among the following was called the ‘Lion of Punjab’ during the Extremist phase? 

(a) Bipin Chandra Pal 

(b) Gopal Krishna Gokhale 

(c) Bal Gangadhar Tilak 

(d) Lala Lajpat Rai 

Ans.(d) 

Sol. The correct answer is (D) Lala Lajpat Rai 

Explanation: 

• Lala Lajpat Rai was popularly known as 'Sher-e-Punjab' (Lion of Punjab). 

• He was a key member of the 'Lal-Bal-Pal' trio of extremist leaders within the Indian National Congress. 

Information Booster: 

• He founded the Punjab National Bank and Lakshmi Insurance Company. 

Additional Knowledge: 

• Bal Gangadhar Tilak (Option C): Known as 'Lokmanya'. 

• Gopal Krishna Gokhale (Option B): Known as a 'Moderate' leader and political mentor to Gandhi. 

 

Q54. Which of the following best describes Rabindranath Tagore’s contribution to the national movement? 

(a) He combined cultural nationalism with a critique of narrow nationalism. 

(b) He was a founder of the Indian National Congress. 

(c) He led the Civil Disobedience Movement. 

(d) He advocated complete boycott of British education. 

Ans.(a) 

Sol. The correct answer is (A) He combined cultural nationalism with a critique of narrow nationalism. 

Explanation: 

• Tagore believed in "Universalism" and was critical of aggressive, narrow nationalism which he felt led to 

conflict. 
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• He contributed to the movement through literature, music (Rabindra Sangeet), and by establishing Visva-

Bharati University. 

Information Booster: 

• Tagore renounced his Knighthood in protest against the Jallianwala Bagh Massacre in 1919. 

Additional Knowledge: 

• Option B: INC was founded by A.O. Hume, W.C. Bonnerjee, etc. 

• Option C: Gandhi led the Civil Disobedience Movement. 

 

Q55. By which authority is the State Election Commissioner appointed? 

(a) Chief Minister 

(b) Chief Justice of High Court 

(c) Chief Justice of Supreme Court 

(d) Governor 

Ans.(d) 

Sol. The correct answer is (D) Governor 

Explanation: 

• The State Election Commissioner is appointed by the Governor of the respective state. 

• This is mandated under Article 243K (for Panchayats) and Article 243ZA (for Municipalities) of the Indian 

Constitution. 

• The State Election Commission is responsible for the superintendence, direction, and control of elections to 

local bodies (Panchayats and Municipalities). 

Information Booster: 

• Removal: Although appointed by the Governor, the State Election Commissioner can only be removed from 

office in the same manner and on the same grounds as a Judge of a High Court (i.e., by the President). 

• Independence: This provision ensures the independence of the State Election Commission from the state 

government. 

Additional Knowledge: 

• Chief Election Commissioner: The CEC of India is appointed by the President. 

• Chief Minister (Option A): Advice is taken from the Cabinet, but the formal appointment is by the Governor. 

 

Q56. Under which of the following ministries does the Kendriya Hindi Sansthan, an autonomous institution, 

operate? 

(a) Ministry of Education 

(b) Ministry of Culture 

(c) Ministry of Home Affairs 

(d) Ministry of Information and Broadcasting 

Ans.(a) 

Sol. The correct answer is (A) Ministry of Education 

Explanation: 

• Kendriya Hindi Sansthan (Central Institute of Hindi) is an autonomous organization established in 1960. 

• It operates under the Department of Higher Education, Ministry of Education (formerly Ministry of Human 

Resource Development), Government of India. 
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• Its primary objective is to promote and propagate the Hindi language and to develop new methodologies for 

teaching Hindi as a second/foreign language. 

• The headquarters of the Sansthan is located in Agra. 

Information Booster: 

• Key Functions: It organizes training programs for Hindi teachers from non-Hindi speaking states and foreign 

countries. 

• Regional Centers: It has regional centers in Delhi, Hyderabad, Guwahati, Shillong, Mysore, Dimapur, 

Bhubaneswar, and Ahmedabad. 

• Sansthan Motto: It plays a vital role in implementing the Official Language Policy of the Union Government. 

Additional Knowledge: 

• Ministry of Culture (Option B): Deals with the preservation and promotion of art and culture but does not 

govern the Kendriya Hindi Sansthan. 

• Ministry of Home Affairs (Option C): The Department of Official Language falls under MHA, which 

oversees the use of Hindi in official work, but the academic institute (KHS) is under the Education Ministry. 

• Ministry of I&B (Option D): Responsible for information, broadcasting, press, and films, not educational 

language institutes. 

 

Q57. How can the President of India resign from office? 

(a) By addressing the resignation letter to the Prime Minister 

(b) By addressing the resignation letter to the Speaker of Lok Sabha 

(c) By addressing the resignation letter to the Chief Justice of India 

(d) By addressing the resignation letter to the Vice-President 

Ans.(d) 

Sol. The correct answer is (D) By addressing the resignation letter to the Vice-President 

Explanation: 

• According to Article 56(1)(a) of the Indian Constitution, the President may resign from his office by writing 

under his hand addressed to the Vice-President. 

• The Vice-President is then required to forthwith communicate the resignation to the Speaker of the Lok 

Sabha. 

Information Booster: 

• Vacancy: If the President's office becomes vacant due to resignation, removal, death, or otherwise, the Vice-

President acts as the President until a new President is elected (within 6 months). 

• Impeachment: The President can be removed from office for 'violation of the Constitution' through the 

process of impeachment (Article 61). 

Additional Knowledge: 

• Prime Minister (Option A): The PM heads the Council of Ministers but does not accept the President's 

resignation. 

• Speaker (Option B): The Speaker is merely informed of the resignation by the Vice-President. 

• Chief Justice (Option C): The CJI administers the oath to the President but does not accept the resignation. 

 

Q58. Which factor is NOT part of demographic transition? 

(a) Fertility rate 

(b) Mortality rate 
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(c) Migration rate 

(d) Literacy curriculum 

Ans.(d) 

Sol. The correct answer is (D) Literacy curriculum 

Explanation: 

• Demographic transition refers to the historical shift from high birth rates and high infant mortality rates in 

societies with minimal technology, education, and economic development, to low birth rates and low death 

rates in societies with advanced technology and education. 

• The core components that drive this transition are Fertility rates (births) and Mortality rates (deaths). 

• Migration is also a critical demographic factor that influences the population structure and size of a specific 

region, though the 'Demographic Transition Model' (DTM) traditionally focuses on natural increase (births 

minus deaths). 

• Literacy curriculum is an educational framework and does not directly measure population change, although 

literacy levels influence demographic behavior. 

Information Booster: 

• Stages of DTM: There are typically five stages: High Stationary (Stage 1), Early Expanding (Stage 2), Late 

Expanding (Stage 3), Low Stationary (Stage 4), and Declining (Stage 5). 

• Natural Increase: This is calculated as the Birth Rate minus the Death Rate. 

• Total Fertility Rate (TFR): The average number of children born to a woman during her lifetime. A TFR of 

2.1 is generally considered the 'replacement level'. 

Additional Knowledge: 

• Fertility rate (Option A): A primary driver of population growth; as societies modernize, this typically 

declines due to better access to contraception and education. 

• Mortality rate (Option B): The first factor to decline in the transition process due to improvements in food 

supply and sanitation. 

• Migration rate (Option C): Refers to the movement of people into (immigration) or out of (emigration) a 

territory, which significantly affects the demographic profile of nations. 

 

Q59. The Human Development Index emphasises people-centric development. Who is credited with creating 

the HDI alongside Amartya Sen? 

(a) Manmohan Singh 

(b) Mahbub ul Haq 

(c) Kaushik Basu 

(d) Jean Drèze 

Ans.(b) 

Sol. The correct answer is (b) Mahbub ul Haq 

Explanation: 

• The Human Development Index (HDI) was conceptualised by Mahbub ul Haq, a Pakistani economist, in 

collaboration with Amartya Sen, an Indian Nobel laureate economist. 

• Mahbub ul Haq introduced the HDI in the first Human Development Report of the United Nations 

Development Programme (UNDP) in 1990. 

• The HDI shifted the focus of development assessment from economic growth (GDP) to people-centric 

development, emphasizing health, education, and standard of living. 
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• Amartya Sen provided the theoretical foundation, particularly the capability approach, which underpins the 

HDI framework. 

Information Booster: 

• HDI values range between 0 and 1, with higher values indicating higher human development. 

• It is published annually in the UNDP Human Development Report. 

• HDI helps compare development levels across countries beyond income alone. 

Additional Knowledge (Information about incorrect options): 

Manmohan Singh (Option a) 

• Renowned Indian economist and former Prime Minister; not associated with HDI creation. 

Kaushik Basu (Option c) 

• Indian economist and former Chief Economist of the World Bank; not involved in HDI formulation. 

Jean Drèze (Option d) 

• Development economist known for work on poverty and social policy; not a co-creator of HDI. 

 

Q60. The unemployment rate is calculated by dividing the number of unemployed people by: 

(a) the number of people who are retired 

(b) the number of employed people 

(c) the total population of the country 

(d) the total labour force 

Ans.(d) 

Sol. The correct answer is (D) the total labour force 

Explanation: 

• The unemployment rate is a key economic indicator defined as the percentage of the labour force that is 

jobless and actively looking for work. 

• Formula: Unemployment Rate = (Number of Unemployed People / Total Labour Force) × 100. 

• The Labour Force includes both the employed and the unemployed (those willing and available to work). 

Information Booster: 

• Excluded Groups: The labour force does not include children, retired people, students not seeking work, or 

those who have given up looking for work. 

• Data Source: In India, the Periodic Labour Force Survey (PLFS) by the NSO provides data on 

unemployment. 

• Types: Common types in India include Disguised Unemployment (agriculture) and Structural 

Unemployment (skill gap). 

Additional Knowledge: 

• Total Population (Option C): Using the total population would dilute the rate incorrectly as it includes infants 

and the elderly who are not eligible to work. 

• Employed People (Option B): This would only give a ratio relative to those working, not the entire pool of 

available workers. 

 

Q61. Which mode of transport is most suitable for transporting heavy and bulky goods over long distances? 

(a) Railways 

(b) Airways 

(c) Roadways 
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(d) Pipelines 

Ans.(a) 

Sol. The correct answer is (a) Railways 

Explanation: 

• Railways are the most suitable mode of transport for carrying heavy and bulky goods such as coal, iron ore, 

cement, food grains, petroleum products, and minerals over long distances. 

• Trains have a high carrying capacity, making them more economical and fuel-efficient compared to road and 

air transport for bulk freight. 

• Rail transport reduces per-unit transportation cost, especially when goods are moved in large quantities 

across regions. 

• They are less affected by weather conditions compared to roadways and provide a stable transport network 

across the country. 

Information Booster: 

• Indian Railways is one of the largest railway networks in the world. 

• Railways play a crucial role in industrial development and national integration. 

• Freight corridors like the Dedicated Freight Corridor (DFC) further enhance bulk transport efficiency. 

Additional Knowledge (Information about incorrect options): 

Airways (Option b) 

• Fastest mode of transport but very expensive. 

• Suitable for light, high-value, or perishable goods, not bulky materials. 

Roadways (Option c) 

• Ideal for short distances and door-to-door delivery. 

• Not economical for heavy goods over long distances. 

Pipelines (Option d) 

• Used only for liquids and gases like oil, gas, and water. 

• Not suitable for transporting general bulky goods. 

 

Q62. Which of the following is the most effective step for mitigating the impact of an earthquake? 

(a) Seismic zoning and earthquake-resistant buildings 

(b) Water harvesting 

(c) Flood barriers 

(d) Deforestation 

Ans.(a) 

Sol. The correct answer is (a) Seismic zoning and earthquake-resistant buildings 

Explanation: 

• Earthquakes cannot be prevented, but their impact can be significantly reduced through proper mitigation 

measures 

• Seismic zoning divides regions based on their earthquake risk, helping planners and authorities enforce 

suitable construction norms. 

• Earthquake-resistant buildings are designed using flexible structures, shock absorbers, reinforced concrete, 

and base isolation techniques that can withstand seismic vibrations. 
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• Countries like Japan and Chile have demonstrated that strict building codes greatly reduce earthquake 

damage. 

Information Booster: 

• India is divided into four seismic zones (II, III, IV, and V) by the Bureau of Indian Standards (BIS). 

• Zone V represents the highest seismic risk (e.g., Himalayan region, Northeast India). 

• The National Disaster Management Authority (NDMA) issues guidelines for earthquake-resistant 

construction 

Additional Knowledge (Information about incorrect options): 

Water harvesting (Option b) 

• Helps in drought management and groundwater recharge, not earthquake mitigation. 

Flood barriers (Option c) 

• Used for flood control, unrelated to seismic hazards. 

Deforestation (Option d) 

• Increases environmental risk and disasters; does not reduce earthquake impact. 

 

Q63. Which natural feature is typical of the Lakshadweep Islands of India? 

(a) Sand dunes 

(b) Volcanic mountains 

(c) Glacial deposits 

(d) Coral formations 

Ans.(d) 

Sol. The correct answer is (D) Coral formations 

Explanation: 

• Lakshadweep is a group of atolls, which are coral reefs that encircle a lagoon. 

• These islands are formed by the accumulation of coral polyps over thousands of years. 

Information Booster: 

• Kavaratti is the administrative capital of Lakshadweep. 

Additional Knowledge: 

• Volcanic (Option B): Characteristics of Andaman and Nicobar (e.g., Barren and Narcondam islands). 

• Sand dunes (Option A): Typical of the Thar Desert in Rajasthan. 

 

Q64. On February 12, 2026, Prime Minister Narendra Modi paid tributes to Swami Dayanand Saraswati on 

his 202nd birth anniversary. Which famous slogan was given by him to encourage a return to the original roots 

of Indian philosophy? 

(a) Jai Hind 

(b) Go Back to the Vedas 

(c) Satyamev Jayate 

(d) Inquilab Zindabad 

Ans.(b) 

Sol. The correct answer is (b) Go Back to the Vedas 

Explanation: 

• Swami Dayanand Saraswati was a renowned philosopher and social reformer who gave the clarion call "Go 

Back to the Vedas" ( Vedo ki aur lauto). 
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• He believed that the Vedas were the source of true knowledge and infallible, serving as the foundation for a 

reformed Hindu society. 

• He aimed to purge Hinduism of superstitious practices and social evils like untouchability and idol worship 

by citing Vedic authority. 

• His birth anniversary, observed on February 12, 2026, marked his 202nd year, celebrating his contributions 

to India's cultural and spiritual awakening. 

• Prime Minister Narendra Modi, in his tribute, highlighted Swami Dayanand's role in instilling self-

confidence and nationalism among Indians. 

Information Booster: 

• Swami Dayanand Saraswati was born in 1824 in Tankara, Gujarat, and his original name was Mul Shankar. 

• He was the first to give the call for Swaraj as "India for Indians" in 1876, a call later taken up by Lokmanya 

Tilak. 

Additional Knowledge: 

• Jai Hind (Option a): This slogan was popularized by Subhas Chandra Bose to foster a sense of unity and 

patriotism. 

• Satyamev Jayate (Option c): A mantra from the Mundaka Upanishad; it was adopted as the national motto 

of India. 

• Inquilab Zindabad (Option d): Originally coined by Hasrat Mohani and later popularized by the 

revolutionary Bhagat Singh. 

 

Q65. Regarding the Khelo India Youth Games: 

1.Hosted by state governments in rotation 

2.Supported by the Sports Authority of India 

3. Conducted every two years 

(a) 1 and 2 only 

(b) 2 and 3 only 

(c) 1 and 3 only 

(d) 1, 2 and 3 

Ans.(a) 

Sol. The correct answer is (A) 1 and 2 only 

Explanation: 

• The Khelo India Youth Games (KIYG) are part of the 'Khelo India' program, a flagship initiative by the 

Ministry of Youth Affairs and Sports to revive sports culture in India. 

• Statement 1 is correct: The games are hosted by different states in rotation to promote sports infrastructure 

across the country (e.g., Haryana, Maharashtra, Tamil Nadu). 

• Statement 2 is correct: The Sports Authority of India (SAI) provides extensive technical and logistical 

support for the execution of these games. 

• Statement 3 is incorrect: KIYG is an annual event, not biennial. It is held every year to provide a platform 

for young athletes at the grassroot level. 

Information Booster: 

• Objective: To identify and nurture sporting talent at a young age and provide financial assistance of ₹5 lakh 

per annum for 8 years to selected athletes. 

• First Edition: Held in 2018 in New Delhi (originally as Khelo India School Games). 
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• Categories: It features two categories: Under-17 years (school students) and Under-21 years (college 

students). 

Additional Knowledge: 

• Khelo India University Games: A separate initiative focused specifically on talent at the university level. 

• Talent Identification: A High-Powered Committee identifies talent from across the country during the games. 

• Inclusion of Indigenous Sports: Recent editions have included traditional Indian sports like Gatka, 

Mallakhamb, Thang-Ta, and Kalaripayattu to promote cultural heritage. 

 

Q66. Match List-I (Aircraft/Asset) with List-II (Role/Description) based on the IAF–RTAF Exercise 2026: 

List-I (Asset) List-II (Role) 

A. Su-30MKI 1. Mid-air Refueller 

B. IL-78 2. Multirole Fighter (IAF) 

C. JAS 39 Gripen 3. Airborne Warning & Control 

D. AWACS 4. Multirole Fighter (RTAF) 

Codes: 

(a) A-2, B-1, C-4, D-3 

(b) A-4, B-3, C-2, D-1 

(c) A-2, B-3, C-4, D-1 

(d) A-1, B-2, C-3, D-4 

Ans.(a) 

Sol. The correct answer is (a) A-2, B-1, C-4, D-3 

Explanation: 

• Su-30MKI (A-2): The primary multirole fighter deployed by the Indian Air Force for this exercise. 

• IL-78 (B-1): A dedicated tanker used for mid-air refuelling, allowing fighter jets to conduct the long-range 

missions required during the drills. 

• JAS 39 Gripen (C-4): The Swedish-origin fighter aircraft utilized by the Royal Thai Air Force (RTAF). 

• AWACS (D-3): Electronic surveillance aircraft used for surveillance integration and battlefield management. 

Information Booster: 

• The AWACS and AEW&C assets provided the "eye in the sky," essential for integrating maritime domain 

awareness during the exercise near the Malacca Strait. 

• The participation of these diverse assets demonstrates the complexity of the drills, moving beyond simple 

dogfights to network-centric warfare. 

Additional Knowledge: 
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• Saab AB, the manufacturer of the Gripen, is currently pitching the Gripen-E/F variant to India for the 114-

aircraft MRFA contract. 

• Other contenders for the MRFA contract include the Dassault Rafale and the Sukhoi Su-57. 

 

Q67. Under the Multirole Fighter Aircraft (MRFA) programme, for how many aircraft is the Indian Air Force 

seeking procurement to address its squadron strength? 

(a) 36 

(b) 114 

(c) 126 

(d) 200 

Ans.(b) 

Sol. The correct answer is (b) 114 

Explanation: 

• The Indian Air Force (IAF) is planning to procure 114 multirole fighter aircraft under the MRFA programme. 

• This massive procurement is intended to bolster the IAF’s declining squadron strength and modernize its 

combat fleet. 

• Swedish manufacturer Saab is aggressively pitching its Gripen-E/F for this contract, offering full-scale 

production under the Make in India initiative. 

• The selection process involves intense competition among global manufacturers, including those producing 

the Rafale and Su-57. 

Information Booster: 

• Saab has also offered technical support for India's indigenous fifth-generation fighter programme, the 

AMCA (Advanced Medium Combat Aircraft). 

• The MRFA programme emphasizes technology transfer and local manufacturing to ensure long-term self-

reliance in defense. 

Additional Knowledge: 

• Dassault Rafale (Option a/c): India previously procured 36 Rafales in a fly-away condition; the original 

MMRCA tender (predecessor to MRFA) was for 126 aircraft. 

• Gripen Features: Saab claims the Gripen-E offers AI-enabled combat systems, advanced sensor fusion, and 

high availability rates. 

 

Q68. Littoral forests are most associated with which kind of ecosystem? 

(a) Tundra ecosystem 

(b) Desert ecosystem 

(c) Grassland ecosystem 

(d) Wetland ecosystem 

Ans.(d) 

Sol. The correct answer is (d) Wetland ecosystem 

Explanation: 

• Littoral forests are found in coastal and deltaic regions, especially along sea coasts, river mouths, and 

estuaries. 

• These forests develop in areas where land is periodically flooded by tidal waters, making them closely linked 

with wetland conditions. 
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• Mangrove forests, a major example of littoral forests, thrive in saline, waterlogged, and marshy 

environments. 

• The vegetation is specially adapted with aerial roots (pneumatophores) to survive in oxygen-deficient, water-

saturated soils. 

Information Booster: 

• Littoral forests act as natural barriers against coastal erosion, cyclones, and tsunamis. 

• They support high biodiversity, including fish, crustaceans, birds, and reptiles. 

• In India, major littoral forests are found in the Sundarbans, Mahanadi, Godavari, Krishna, and Kaveri deltas. 

Additional Knowledge (Information about incorrect options): 

Tundra ecosystem (Option a) 

• Found in polar regions with permafrost; no tree growth possible. 

Desert ecosystem (Option b) 

• Characterized by extremely low rainfall; does not support littoral vegetation. 

Grassland ecosystem (Option c) 

• Dominated by grasses with sparse trees; unrelated to tidal or coastal forests. 

 

Q69. India’s _______ Act provides protection for wild animals, birds, and plants. 

(a) Environment and Forest Act 

(b) Wildlife Protection Act 

(c) Biological Diversity Act 

(d) Environment Protection Act 

Ans.(b) 

Sol. The correct answer is (b)Wildlife Protection Act 

Explanation: 

• The Wild Life (Protection) Act, 1972 (WLPA) is the primary and most important legislation in India 

specifically enacted for the protection of wild animals, birds, and plant species across the country. 

• The Act provides a robust legal framework to prohibit hunting of wild animals and regulate the trade of 

wildlife and their derivatives. 

• It facilitates the establishment of a network of protected areas, including National Parks and Wildlife 

Sanctuaries, to safeguard natural habitats. 

• The Act uses a system of six (now four after the 2022 amendment) Schedules to list species with varying 

levels of protection, with Schedule I offering the highest protection and most stringent penalties for violations. 

Information Booster: 

The WLPA was enacted on September 9, 1972, due to concerns about declining wildlife in India. The 42nd 

Amendment Act of 1976 placed forests and wildlife protection on the Concurrent List, allowing both central 

and state governments to legislate. Article 48A of the Indian Constitution directs the State to protect and 

improve the environment and safeguard wildlife, while Article 51A(g) makes it a fundamental duty of citizens 

to protect the natural environment. 

Additional Knowledge: 

(a) Environment and Forest Act: This is not the official name of a specific act. Relevant areas are covered by 

acts like the Environment (Protection) Act of 1986 and the Forest (Conservation) Act of 1980. 

(c) Biological Diversity Act (2002): This Act focuses on the conservation of biological diversity and 

sustainable use of genetic resources. 
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(d) Environment Protection Act (1986): This is broader legislation for overall environmental protection (air, 

water, soil) but the WLPA specifically addresses wild species and their habitats 

 

Q70. Oxalic acid is present in: 

(a) Spinach 

(b) Onion 

(c) Banana 

(d) Carrot 

Ans.(a) 

Sol. Correct Answer: (a) 

Explanation: 

Spinach contains a high amount of oxalic acid, which can bind with calcium and reduce its absorption. 

Additional Information: 

• Oxalic acid is common in leafy vegetables. • Excess intake may lead to kidney stone formation. 

 

Q71. The fluffiness of cakes and idlis is due to the release of carbon dioxide gas when baking soda reacts with 

which of the following? 

(a) Salt 

(b) Acid 

(c) Sugar 

(d) Oil 

Ans.(b) 

Sol. The correct answer is (b) Acid. 

• Baking soda (sodium bicarbonate) releases CO₂ when it reacts with an acid. 

• The gas gets trapped, making cakes and idlis soft and fluffy. 

Information Booster: 

• Common acids used: curd, lemon juice, vinegar. 

• Reaction produces CO₂, water, and a salt. 

• Heat accelerates gas release during cooking. 

Additional Knowledge: 

• Baking powder already contains both acid and base. 

• Without acid, baking soda leaves a bitter taste. 

• Fermentation in idli batter also releases CO₂ naturally. 

 

Q72. Which gas is mainly responsible for acid rain? 

(a) Carbon monoxide 

(b) Sulphur dioxide 

(c) Methane 

(d) Ozone 

Ans.(b) 

Sol. The correct answer is (B) Sulphur dioxide 

Explanation: 
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• Acid rain is caused by a chemical reaction that begins when compounds like sulphur dioxide ($SO_2$) and 

nitrogen oxides are released into the air. 

• These substances can rise very high into the atmosphere, where they mix and react with water, oxygen, and 

other chemicals to form acidic pollutants. 

Information Booster: 

• Acid rain has a pH level of around 4.2–4.4, whereas normal rain is slightly acidic with a pH of about 5.6. 

Additional Knowledge: 

• Acid rain causes damage to buildings (like the Taj Mahal), forests, and aquatic life. 

 

Q73. The compass needle behaves as a tiny ________. 

(a) Conductor 

(b) Magnet 

(c) Resistor 

(d) Insulator 

Ans.(b) 

Sol. The correct answer is (B) Magnet 

Explanation: 

• A compass needle is a small, lightweight magnet balanced on a nearly frictionless pivot point. 

• It aligns itself with the Earth's magnetic field, with its north-seeking pole pointing toward the Earth's 

magnetic North Pole. 

Information Booster: 

• The end of the needle that points north is called the 'North Pole' of the magnet. 

• Like poles repel, and opposite poles attract; hence the needle reacts to external magnetic fields. 

Additional Knowledge: 

• Conductor (Option A): A material that allows electricity to flow through it easily. 

• Insulator (Option D): A material that resists the flow of electricity. 

 

Q74. Which force arises when a body is immersed in a fluid and displaces the fluid? 

(a) Normal reaction 

(b) Buoyant force 

(c) Spring force 

(d) Tension 

Ans.(b) 

Sol. The correct answer is (B) Buoyant force 

Explanation: 

● When a body is immersed in a fluid, it displaces some amount of the fluid. 

● The fluid exerts an upward force on the body known as buoyant force (or upthrust). 

● This force is responsible for making objects float or feel lighter in water. 

Information Booster: 

● According to Archimedes’ Principle, the buoyant force is equal to the weight of the displaced fluid. 

● Buoyant force acts opposite to gravity. 

Additional Knowledge: 

● A – Normal reaction: Acts perpendicular to surfaces in contact; not related to fluids. 
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● C – Spring force: Force exerted by a compressed or stretched spring. 

● D – Tension: Force in strings or ropes; unrelated to fluid immersion. 

 

 

Q75. Who wrote the book 'The Social Contract' which is believed to have inspired the revolutionaries in the 

French Revolution? 

(a) Thomas Hobbes 

(b) John Locke 

(c) Jean-Jacques Rousseau 

(d) Montesquieu 

Ans.(c) 

Sol. The correct answer is (c) Jean-Jacques Rousseau. 

Explanation: 

● Rousseau's "The Social Contract" (1762) argued that legitimate political authority comes from a social 

contract agreed upon by all citizens. 

● His ideas on "General Will" deeply influenced the leaders of the French Revolution. 

Information Booster: 

● The famous opening line of the book is: "Man is born free, and everywhere he is in chains." 

Additional Knowledge: 

● Montesquieu: Proposed the "Separation of Powers" in his book "The Spirit of Laws." 

● John Locke: Known for "Two Treatises of Government." 

 

Q76. To add a watermark in MS Word 2010 document, one has to click on the '' tab and then select the 

'Watermark' option provided in the '' group. 

(a) Page Layout, Page Background 

(b) View, Page Background 

(c) Layout, Page Background 

(d) Insert, Page Background 

Ans.(a) 

Sol. To add a watermark in an MS Word 2010 document, one has to click on the "Page Layout" tab and then 

select the 'Watermark' option provided in the "Page Background" group. 

Important Key Points: 

• Page Layout Tab: The Page Layout tab contains various options for formatting the document layout, 

including adding a watermark. 

• Page Background Group: The Watermark option is located under the Page Background group, where users 

can choose from predefined watermarks or customize their own. 

• Efficiency: This is an easy way to add a watermark to the document, enhancing its visual appeal or making 

it suitable for marking confidential or draft documents. 

Knowledge Booster: 

• View Tab: The View tab deals with document viewing modes and does not include the watermark option. 

• Layout Tab: The Layout tab focuses on page setup and text alignment, not adding watermarks. 

• Insert Tab: The Insert tab is for inserting objects such as images, tables, or text boxes, but not specifically 

for watermarks. 
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Q77. Which of the following keyboard shortcuts is used to run Spelling and Grammar Check in MS Word 

2010? 

(a) F2 

(b) F7 

(c) F1 

(d) F9 

Ans.(b) 

Sol. In Microsoft Word 2010, the keyboard shortcut F7 is used to run the Spelling and Grammar Check. When 

pressed, it initiates the tool that scans the document for any spelling or grammatical errors, and allows the user 

to correct them. 

Important Key Points: 

1. F7: This is the default keyboard shortcut for running the Spelling and Grammar check in MS Word 2010. 

Pressing F7 opens the Spelling and Grammar dialog box, highlighting errors, and providing suggestions for 

corrections. 

2. Functionality: The shortcut helps users quickly identify and fix errors in their documents, improving their 

writing. 

3. Efficiency: This shortcut speeds up the proofreading process, allowing you to instantly begin checking for 

mistakes in spelling and grammar. 

Knowledge Booster: 

• F2: This shortcut is used to rename an item in Windows Explorer, not for Spelling and Grammar check. 

• F1: F1 opens the Help menu in most programs, including MS Word. 

• F9: F9 is used for refreshing fields or recalculating formulas in MS Word or Excel. 

 

Q78. Which of the following keyboard shortcuts is equivalent to CTRL + S to save an open file in MS Word? 

(a) Shift + F5 

(b) Ctrl + F5 

(c) Shift + F12 

(d) Ctrl + F12 

Ans.(c) 

Sol. In MS Word, the keyboard shortcut Shift + F12 is equivalent to Ctrl + S and is used to save an open file. 

Both shortcuts perform the same function of saving the current document. 

Important Key Points: 

1. Shift + F12: This is a keyboard shortcut that can be used to save the current document in MS Word, just 

like Ctrl + S. 

2. Ctrl + S: This is one of the most widely used and well-known shortcuts across various software for saving 

a document. It is a universal shortcut for saving the current file without having to navigate through the menu. 

3. Consistency in Shortcuts: Both Shift + F12 and Ctrl + S are designed to help users save their work quickly 

without interrupting their workflow. 

Knowledge Booster: 

• Shift + F5: This shortcut takes you to the last place where you made an edit in your document. It's useful 

when you are revisiting a document and need to jump to your last edit point. 
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• Ctrl + F5: This restores the document window to its default size, useful if you've resized the window 

previously. 

• Ctrl + F12: This shortcut opens the "Open" dialog box in MS Word, allowing you to open a file, but it is not 

used for saving documents. 

 

Q79. To compare two versions of an MS Word 2007 document, one must go to the ______ tab and click on 

the ______ option within the ‘Compare’ group. 

(a) View, Window 

(b) Review, Track Changes 

(c) Review, Tracking 

(d) Review, Compare 

Ans.(d) 

Sol. To compare two versions of a document in MS Word 2007, you need to go to the Review tab and click 

on the Compare option within the Compare group. This feature allows you to compare the differences between 

two documents, highlighting the changes made between them. It can be useful when reviewing document 

revisions or tracking changes made by different users. 

• The Compare feature shows both the original and revised documents, indicating any differences, such as 

added or deleted text. 

Important Key Points: 

1. Review Tab: The Review tab is where you find tools for document revision, such as Track Changes, 

Compare, and Comments. 

2. Compare Option: The Compare option under the Compare group allows you to select two documents and 

compare their content to see the changes that were made. 

Knowledge Booster: 

• Track Changes: The Track Changes feature, also found under the Review tab, allows users to make edits 

that are easily visible to others. Compare is used to compare different versions of documents, while Track 

Changes is used in a single document to show revisions. 

• Window Option: The Window option under the View tab is for managing open documents in separate 

windows, not for comparing documents. 

 

Q80. What is gutter margin? 

(a) Margin that is added to the left margin when printing 

(b) Margin that is added to the right margin when printing 

(c) Margin that is added to the binding side of the page when printing 

(d) Margin that is added to the outside of the page when printing 

Ans.(c) 

Sol. A gutter margin is an additional margin added on the binding side of a document to ensure text and images 

are not obscured when bound. 

Important Key Points: 

1. Binding Allowance: Ensures readability and prevents text from getting hidden in the binding. 

2. Used in Book Layouts: Commonly used in books and printed reports that require binding. 

3. Flexible Placement: The gutter can be on the left or right, depending on binding style. 

Knowledge Booster: 
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• Left Margin: Regular margin on the left side; not specifically for binding. 

• Right Margin: Regular margin on the right side; not specific to binding needs. 

• Outside Margin: Refers to margins opposite the binding side, often on the outer edges. 

 

Q81. Themes in Powerpoint can be found under which tab? 

(a) Animation Tab 

(b) Transition Tab 

(c) Design Tab 

(d) Insert Tab 

Ans.(c) 

Sol. The correct answer is Design Tab. PowerPoint themes are located under the Design Tab, where users can 

apply, customize, and modify themes to maintain consistency in slide presentations. 

Important Key Points: 

1. The Design Tab contains pre-designed themes that apply styles, colors, and fonts across slides. 

2. The Variants feature allows users to modify theme colors and fonts for customization. 

3. Users can further tweak slide designs using the Format Background option within this tab. 

Knowledge Booster: 

• Animation Tab controls object movement but does not handle slide themes. 

• Transition Tab applies effects between slides, but doesn't modify their overall design. 

• Insert Tab lets users add elements like images, charts, and text boxes—not themes. 

 

Q82. Which of the following options in PowerPoint allows you to see all the slides at once as thumbnails? 

(a) Reading View 

(b) Slide Sorter View 

(c) Outline View 

(d) Slide Show View 

Ans.(b) 

Sol. The correct answer is (B) Slide Sorter View. 

Explanation: 

• Slide Sorter View allows you to see all the slides at once as thumbnails. This view is useful for quickly 

organizing, rearranging, or deleting slides in the presentation. 

Information Booster: 

• Slide Sorter View is particularly helpful for managing large presentations, as it provides a clear overview 

of the entire slide deck at once. 

Additional Information: 

• (A) Reading View: Displays the slides one by one in a window, but not as thumbnails. 

• (C) Outline View: Shows the text content of your slides in an outline format, not thumbnails. 

• (D) Slide Show View: Displays the presentation in full-screen mode, one slide at a time for presenting. 

 

Q83. Slide show options available to the presenter include all of the following except 

(a) Transitions command 

(b) Speaker notes command 

(c) Meeting reminder command 
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(d) Navigation commands 

Ans.(c) 

Sol. Meeting reminder command is not a standard feature available in PowerPoint's slideshow options for the 

presenter. The other options (Transitions, Speaker notes, and Navigation) are part of the tools available during 

a presentation. 

Important Key Points: 

1. Transitions Command: This allows the presenter to set the effect between slides in the presentation. 

2. Speaker Notes Command: This provides a space for the presenter to add notes for reference while 

presenting. 

3. Navigation Commands: These tools allow the presenter to navigate between slides during the presentation, 

using options such as "Next" or "Previous." 

Knowledge Booster: 

• Transitions Command: This option is available to customize how one slide moves to the next, adding visual 

appeal to the presentation. 

• Speaker Notes Command: Speaker notes are available for presenters to view important points during the 

presentation without displaying them on the screen. 

• Navigation Commands: These are used to control the progression of the slideshow. 

 

Q84. How can you move the focus to the first floating shape, such as an image or a text box in MS-

PowerPoint? 

(a) Ctrl + Alt + C 

(b) Ctrl + Shift + H 

(c) Ctrl + Alt + 5 

(d) Ctrl + Shift + M 

Ans.(c) 

Sol. In Microsoft PowerPoint, Ctrl + Alt + 5 keyboard shortcut is used to quickly move the focus to the first 

floating shape, such as a text box or an image in MS PowerPoint. 

Important Key Points: 

1. Keyboard Shortcuts: Mastering keyboard shortcuts like Ctrl + Alt + 5 can significantly enhance 

productivity and efficiency when creating and editing presentations. 

2. Floating Shapes: Floating shapes in PowerPoint include images, text boxes, and other objects that can be 

layered over slide content, which can be navigated using specific shortcuts. 

3. Accessibility: Using keyboard shortcuts improves accessibility for users who may have difficulty using a 

mouse or prefer keyboard navigation. 

4. Quick Navigation: This specific shortcut streamlines the process of selecting and editing floating objects, 

enabling faster adjustments and modifications. 

Knowledge Booster: 

• Ctrl + Alt + C: This shortcut does not perform any recognized action related to floating shapes in 

PowerPoint. 

• Ctrl + Shift + H: This combination is also not designated for moving the focus to floating shapes within 

PowerPoint. 

• Ctrl + Shift + M: This shortcut typically does not correlate with selecting or navigating floating shapes in 

PowerPoint and may refer to different functionalities in other software. 
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Q85. Which of the following keyboard shortcuts is used to open the font window in MS PowerPoint, where 

you can adjust the font size, style, type, etc.? 

(a) Alt + Ctrl + F 

(b) Ctrl + F 

(c) Ctrl + W 

(d) Ctrl + T 

Ans.(d) 

Sol. The keyboard shortcut Ctrl + T is used to open the Font window in Microsoft PowerPoint, where you can 

adjust the font size, style, type, and other font-related settings. 

Important Key Points: 

1. Ctrl + T Shortcut: Pressing Ctrl + T in Microsoft PowerPoint opens the Font dialog box. This allows users 

to change various font attributes such as size, style (bold, italic), and typeface. 

2. Font Settings: In the font window, you can modify font properties to personalize text formatting, including 

the ability to select specific fonts and styles that best suit the presentation. 

3. Efficiency: Using keyboard shortcuts like Ctrl + T helps improve productivity, allowing users to access 

frequently used features like font settings without navigating through multiple menus. 

Knowledge Booster: 

• Alt + Ctrl + F: This is not the correct shortcut for opening the font dialog box in PowerPoint. It is not 

associated with any standard PowerPoint functionality. 

• Ctrl + F: This shortcut is used for Find, which helps you search for specific text in the presentation, not for 

opening the font window. 

• Ctrl + W: This shortcut is used for closing the current window or presentation, not for opening the font 

settings. 

 

Q86. In MS-Excel 2010 ______ is used for hiding columns within the sheet. 

(a) Ctrl + 9 

(b) Alt + 0 

(c) Alt + 9 

(d) Ctrl + 0 

Ans.(d) 

Sol. The correct answer is (d) Ctrl + 0. 

• In MS Excel 2010, the shortcut key Ctrl + 0 is used to hide selected columns in a worksheet. 

• This feature helps organize data and improve visibility by temporarily removing unnecessary columns. 

Information Booster: 

• To unhide columns, use the shortcut Ctrl + Shift + 0. 

• Similarly, Ctrl + 9 hides rows, and Ctrl + Shift + 9 unhides them. 

• You can also hide columns via Home → Format → Hide & Unhide → Hide Columns. 

• Hiding does not delete data; it just conceals it from view. 

• Useful for managing large data sheets during analysis. 

Additional Knowledge: 

• Rows and columns can also be hidden through right-click → Hide option. 

• Excel 2010 supports up to 16,384 columns (A to XFD). 
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• Hidden columns retain their formulas and references in calculations. 

• By 2025, Excel includes enhanced visibility control options for collaborative workbooks. 

• Hiding columns helps maintain data privacy while presenting reports. 

 

Q87. ______ function in MS-Excel 2010 counts how many values are in the list of arguments. 

(a) COUNTA 

(b) IF 

(c) CEILING 

(d) COUNTIF 

Ans.(a) 

Sol. The correct answer is (a) COUNTA. 

• COUNTA counts the number of non-empty cells in a given range. 

• It counts numbers, text, logical values, and other entries. 

• Unlike COUNT, it does not restrict itself to numeric values. 

Information Booster: 

• COUNT → counts only numeric cells. 

• COUNTBLANK → counts empty cells. 

• COUNTIF → counts cells meeting a single condition. 

• CEILING → rounds a number to the nearest specified multiple. 

• Excel functions help in data analysis and automation. 

Additional Knowledge: 

• IF (Option b) performs logical tests. 

• CEILING (Option c) rounds numbers upward. 

• COUNTIF (Option d) counts based on criteria, not total values. 

 

Q88. In MS-Excel, what is the keyboard shortcut for creating a chart from the selected cells? 

(a) F3 

(b) F5 

(c) F7 

(d) F11 

Ans.(d) 

Sol. Pressing F11 in MS-Excel instantly creates a chart from the selected data in a new worksheet. This 

shortcut is convenient for quickly visualizing data. 

Important Key Points: 

1. Quick Chart Creation: F11 provides an efficient way to create a chart without navigating menus. 

2. New Worksheet: The chart is created in a separate worksheet by default. 

3. Data Visualization: Visualizing data through charts helps in analyzing trends and patterns. 

Knowledge Booster: 

• F3: Used to paste a defined name in Excel. 

• F5: Opens the “Go To” dialog box. 

• F7: Opens the Spelling and Grammar check. 
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Q89. In MS Excel 365, which chart is used when category names are long or when comparing data over a 

period of time? 

(a) Pie chart 

(b) Bar chart 

(c) Column chart 

(d) Line chart 

Ans.(b) 

Sol. In MS Excel 365, a Bar chart is used when category names are long or when comparing data over a period 

of time. It displays data in horizontal bars, making it easier to read long category labels. 

Important Key Points: 

1. Horizontal Representation: Bar charts plot categories on the vertical axis and values on the horizontal axis, 

accommodating longer category names effectively. 

2. Comparative Analysis: They are ideal for comparing data across categories, especially when data involves 

large numbers or percentages. 

3. Visual Clarity: The horizontal layout ensures that longer text labels remain legible without overlapping or 

truncation. 

4. Applications: Bar charts are commonly used in business reports and presentations for clear and concise 

comparisons. 

Knowledge Booster: 

• Pie chart: This chart is used for showing proportions or percentages within a whole but is not suitable for 

comparing over time or handling long category names. 

• Column chart: Similar to a bar chart but with vertical bars, making it less effective for long category names. 

• Line chart: Best for displaying trends over time but not ideal for comparing categories with long labels. 

 

Q90. In MS Access 2016, which command under the External Data Tab is used to fetch data from a remote 

SQL database? 

(a) ODBC Database 

(b) Report Wizard 

(c) Query Design 

(d) Form Design 

Ans.(a) 

Sol. In MS Access 2016, the command under the External Data Tab used to fetch data from a remote SQL 

database is ODBC Database. This feature allows users to establish a connection to external databases using 

Open Database Connectivity (ODBC), enabling seamless data integration and access from remote SQL 

databases. 

Important Key Points: 

1. Remote Connection: Establishes a link to external SQL databases for real-time data access. 

2. Seamless Integration: Facilitates integration with various database systems using ODBC. 

3. Data Fetching: Enables users to fetch and manipulate data directly from remote databases without importing 

it. 

Knowledge Booster: 

• Report Wizard: Used for creating structured summaries of data in the form of reports, not for fetching data 

from external databases. 
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• Query Design: This feature is used to design queries for retrieving and manipulating data within Access, not 

for establishing connections to remote databases. 

• Form Design: Assists in creating forms for data entry and interaction within Access, not for connecting to 

external databases. 

 

Q91. Which field size is not available for the Number data type in MS Access? 

(a) 2 bytes 

(b) 4 bytes 

(c) 8 bytes 

(d) 16 bytes 

Ans.(d) 

Sol. In MS Access, the field size of 16 bytes is not available for the Number data type. The available field 

sizes for the Number data type in MS Access are typically 1 byte, 2 bytes, 4 bytes, and 8 bytes, each 

corresponding to different numerical data types and storage capacities. 

Important Key Points: 

1. 1 Byte: Used for the Byte data type, storing values from 0 to 255. 

2. 2 Bytes: Used for the Integer data type, storing values from -32,768 to 32,767. 

3. 4 Bytes: Used for the Long Integer data type, storing values from -2,147,483,648 to 2,147,483,647. 

4. 8 Bytes: Used for the Double data type, storing large floating-point numbers. 

Knowledge Booster: 

• 16 Bytes: This field size is not supported for the Number data type in MS Access, as it exceeds the storage 

requirements for numerical data. 

 

Q92. Which feature in the External Data Tab is used to save an MS Access table as an Excel spreadsheet? 

(a) Export Wizard 

(b) Import & Link 

(c) Query Design 

(d) Form Wizard 

Ans.(a) 

Sol. In MS Access 2016, the feature in the External Data Tab used to save an Access table as an Excel 

spreadsheet is the Export Wizard. This tool guides users through the process of exporting data from Access to 

various formats, including Excel, making data sharing and analysis seamless. 

Important Key Points: 

1. Export to Excel: Enables users to save Access tables as Excel spreadsheets for easy data manipulation and 

sharing. 

2. User-Friendly: Provides a step-by-step guide to ensure the export process is straightforward and efficient. 

3. Versatility: Supports exporting to multiple formats, ensuring data can be used across different applications. 

Knowledge Booster: 

• Import & Link: This feature is used to bring external data into Access or link to external databases, not for 

exporting data. 

• Query Design: This is used to create and design queries within Access, not for saving tables as Excel 

spreadsheets. 

• Form Wizard: This assists in creating data entry forms, not for exporting data to other formats. 
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Q93. Which of the following relationships can be formed in an MS Access database design? 

(a) One-to-one 

(b) One-to-many 

(c) Many-to-many 

(d) All these 

Ans.(d) 

Sol. In MS Access, all three types of relationships— One-to-one, One-to-many, and Many-to-many—can be 

created to organize and manage relational databases efficiently. These relationships define how tables in a 

database are connected and interact with each other. 

Important Key Points: 

1. One-to-one: Each record in Table A corresponds to exactly one record in Table B. 

2. One-to-many: A single record in Table A can be associated with multiple records in Table B. 

3. Many-to-many: Multiple records in Table A can relate to multiple records in Table B, usually implemented 

through a junction table. 

Knowledge Booster: 

• One-to-one relationships are less common and are used when data needs to be split for security or 

organizational purposes. 

• One-to-many relationships are the most common and are widely used in databases. 

• Many-to-many relationships require an intermediary (junction) table to handle the relationship effectively. 

 

Q94. Which of the following keyboard shortcuts is used to activate a browser tab to the right of the current 

tab in a Chrome browser? 

(a) Ctrl + Right arrow 

(b) Ctrl + Page down 

(c) Alt + Left arrow 

(d) Ctrl + Page up 

Ans.(b) 

Sol. In Google Chrome, the keyboard shortcut Ctrl + Page Down is used to activate the browser tab to the 

right of the current tab. This allows you to quickly switch between tabs from left to right. 

Important Key Points: 

1. Ctrl + Page Down: This moves the focus to the next tab to the right in the browser. 

2. Tab Navigation: Chrome allows efficient tab navigation with keyboard shortcuts, speeding up the browsing 

experience. 

Knowledge Booster: 

• Ctrl + Right arrow: This is not a valid shortcut in Chrome for tab switching. 

• Alt + Left arrow: This shortcut is used for navigating back in the browser, not for switching tabs. 

• Ctrl + Page up: This moves you to the previous tab (left of the current tab), not the next one. 

 

Q95. Which browser extension could be used to download an entire web page for offline use? 

(a) Web ScrapBook 

(b) Grammarly 

(c) AdBlock 
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(d) Evernote 

Ans.(a) 

Sol. Web ScrapBook is a browser extension designed to save and organize web pages for offline viewing. It 

allows users to capture entire web pages, including text, images, and links, and store them in a structured way 

for later access without internet connectivity. 

Important Key Points: 

1. Web ScrapBook is ideal for archiving web content for study, research, or reference. 

2. It supports single-page or multi-page capture, with options to clean up ads and scripts. 

3. Saved pages can be browsed offline using a file viewer or browser extension. 

Knowledge Booster: 

• Grammarly checks grammar and writing clarity but does not save web pages. 

• AdBlock is used to block ads, not capture or save pages. 

• Evernote is a note-taking tool that can clip content, but it's not primarily for full-page offline storage. 

 

Q96. In Gmail, what do you use when you receive a mail and want to send the mail in response of the same 

mail and to the original send only? 

(a) Forward 

(b) Both Reply and Forward 

(c) Reply All 

(d) Reply 

Ans.(d) 

Sol. In Gmail, when you want to send a response to the original sender only for a received email, you use the 

Reply option. This ensures that your response is directed solely to the person who sent you the mail, without 

involving any other recipients or forwarding the email to someone else. 

Important Key Points: 

1. Reply sends the response only to the original sender. 

2. This is ideal for private or direct conversations without involving additional recipients. 

3. Other options, like Reply All or Forward, involve other recipients or external parties. 

Knowledge Booster: 

• Forward: Sends the original email to a new recipient, not the original sender. 

• Both Reply and Forward: This is not a valid option in Gmail. 

• Reply All: Sends the response to all recipients of the email, including the original sender and others in the 

email chain. 

 

Q97. Which of the following is an address on the World Wide Web that is used to access specific web resources 

and is the specific path to a resource? 

(a) Hyperlink 

(b) Web server 

(c) Web pages 

(d) Uniform resource locator 

Ans.(d) 
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Sol. The Uniform Resource Locator (URL) is the unique address used to access specific resources on the 

World Wide Web. It specifies the location of a resource on the server and the protocol to retrieve it, such as 

HTTP or HTTPS. 

Important Key Points: 

1. A URL typically consists of a protocol (e.g., HTTP), a domain name, and a resource path. 

2. It enables users to directly access web pages, files, or other online content. 

3. URLs are essential for web navigation and resource identification. 

Knowledge Booster: 

• Hyperlink: A clickable link that redirects users to a URL but is not the URL itself. 

• Web server: A system that hosts and serves web content but is not an address. 

• Web pages: The content or document accessed via a URL, not the address itself. 

 

Q98. Which of the following is primarily a system configuration tool rather than a direct visual element of the 

MS Windows desktop interface? 

(a) Start Menu 

(b) Taskbar 

(c) Control Panel 

(d) Recycle Bin 

Ans.(c) 

Sol. The correct answer is: (C) Control Panel 

Explanation: 

● The Control Panel is mainly used for system configuration and settings, not as a direct visual element on 

the desktop. 

● It manages hardware, software, user accounts, and system preferences. 

● Other options are visible and directly interactable from the desktop interface. 

Information Booster: 

● Start Menu → Access to apps & system tools 

● Taskbar → Shows open apps and pinned items 

● Recycle Bin → Stores deleted files temporarily 

● Control Panel → Used for settings and configuration 

● Windows 10 and 11 also include Settings app as an alternative 

Additional Knowledge: 

● Start Menu is directly visible on the desktop 

● Taskbar is always present at screen bottom 

● Recycle Bin is a desktop icon 

● Control Panel is accessed via search or settings, not directly on desktop 

 

Q99. Whenever a program is run or a window is opened, an icon representing the program appears on which 

of the following? 

(a) Status bar 

(b) Menu bar 

(c) Task Bar 

(d) Tool bar 
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Ans.(c) 

Sol. In Microsoft Windows operating systems, when a program is executed or a window is opened, its icon 

appears on the Task Bar — usually located at the bottom of the screen by default. 

The Task Bar serves multiple purposes: 

• It displays open and running applications 

• Allows users to switch between programs 

• Hosts system notifications, time, volume, and quick launch icons 

Important Key Points: 

1. The Task Bar shows icons of all currently open windows and programs. 

2. It includes the Start menu, pinned apps, running app previews, and notification area. 

3. It helps in multi-tasking by allowing quick switching between applications. 

4. It is distinct from the Tool Bar which exists inside applications (like MS Word). 

5. Right-clicking on the taskbar gives access to various window and system options. 

Knowledge Booster: 

• (a) Status bar: Located at the bottom inside some application windows, shows status messages (e.g., page 

number, word count). 

• (b) Menu bar: Displays application menus like File, Edit, View — not for running apps. 

• (d) Tool bar: Contains shortcuts for tools/functions inside a specific program — not system-wide running 

icons. 

 

Q100. Which protocol is commonly used to send and receive emails on the internet? 

(a) FTP 

(b) SMTP 

(c) HTTPS 

(d) WWW 

Ans.(b) 

Sol. SMTP (Simple Mail Transfer Protocol) is the standard protocol used on the internet to send emails from 

a client to a mail server and between mail servers. When a user clicks “Send” on an email, SMTP is responsible 

for transferring that message to the recipient’s mail server. While other protocols are used for retrieving emails, 

SMTP specifically handles the sending process, making it the correct answer in this context. 

Important Key Points: 

1. Full Form of SMTP: SMTP stands for Simple Mail Transfer Protocol. 

2. Primary Function: Used to send outgoing emails from email clients to servers and between mail servers. 

3. How Email Communication Works? 

• SMTP → sending emails 

• POP3 / IMAP → receiving emails 

4. Common Ports Used: Port 25 (traditional), Port 587 (secure submission), Port 465 (secure SMTP). 

5. Applications: Used by email services like Gmail, Outlook, Yahoo Mail, and enterprise mail servers. 

6. Why It’s Essential? Without SMTP, email messages could not be transmitted across the internet. 

Knowledge Booster: 

• Why option (a) FTP is incorrect? FTP is used for file transfer, not email communication. 

• Why option (c) HTTPS is incorrect? HTTPS is used for secure web browsing, not for sending emails. 

• Why option (d) WWW is incorrect? WWW (World Wide Web) is a service for accessing web pages, not a 

communication protocol for email. 
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